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 Caution 
 

 
US Federal law restricts this device to sale by or on the order of a 
physician. 
 

 

Copyright 
 
© Copyright 2012, Welch Allyn. All rights are reserved. To support the intended use of the 
product described in this publication, the purchaser of the product is permitted to copy this 
publication, for internal distribution only, from the media provided by Welch Allyn. Welch Allyn 
assumes no responsibility for any injury to anyone, or for any illegal or improper use of the 
product, that may result from failure to use this product in accordance with the instructions, 
cautions, warnings, or statement of intended use published in this manual.  Unauthorized 
copying of this publication may not only infringe copyright but also reduce the ability of Welch 
Allyn to provide accurate and up-to-date information to users and operators alike. 
 
Welch Allyn

®
, CardioPerfect

®
 Workstation and SpiroPerfect

®
 are registered trademarks of 

Welch Allyn.  
 
Software in this product is Copyright 2012, Welch Allyn. All rights are reserved. The software 
is protected by United States of America copyright laws and international treaty provisions 
applicable worldwide.  Under such laws, the licensee is entitled to use the copy of the 
software provided on the original distribution medium. The software may not be copied, 
decompiled, reverse-engineered, disassembled or otherwise reduced to human-perceivable 
form. This is not a sale of the software or any copy of the software; all right, title and 
ownership of the software remains with Welch Allyn.  
 
The information contained in this manual is subject to change without notice.  
All changes will be in compliance with regulations governing manufacture of medical 
equipment.  
 

User responsibility 
This product is designed to perform in conformity with the description thereof contained in this 
manual and accompanying labels and inserts, when assembled, operated, maintained and 
repaired in accordance with the instructions provided. A defective product should not be used. 
Parts that are broken, plainly worn, missing or incomplete, distorted or contaminated should 
be replaced immediately. Should any repair or replacement become necessary, we 
recommend that service be performed at the nearest approved service center. The user of the 
product shall have the sole responsibility for any malfunction, which results from improper 
use, faulty maintenance, improper repair, damage or alteration by anyone other than Welch 
Allyn or their authorized service personnel. 
 

Accessories 
The Welch Allyn warranty can only be honored if you use Welch Allyn approved accessories 
and replacement parts. 
 

 Caution 

 
Use of accessories other than those recommended by Welch Allyn 
may compromise product performance. 
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Warranty, Service, and Spare Parts 
 
Warranty 
All repairs on products under warranty must be performed or approved by Welch Allyn. 
Unauthorized repairs will void the warranty. In addition, whether or not covered under 
warranty, any product repair shall exclusively be performed by Welch Allyn certified service 
personnel. 
 
Assistance and Parts 
If the product fails to function properly or if assistance, service, or spare parts are required, 
contact the nearest Welch Allyn Technical Support Center.  
 
USA 1-800-535-6663 Canada 1-800-561-8797 
Latin America (+1) 305-669-9003 South Africa (+27) 11-777-7555 
European Call Center (+353) 46-90-67790 Australia (+61) 2-9638-3000 
United Kingdom (+44) 207-365-6780 Singapore (+65) 6419-8100 
France (+33) 1-55-69-58-49 Japan (+81) 42-703-6084 
Germany (+49) 695-098-5132 China (+86) 21-6327-9631 
Netherlands (+31) 202-061-360  Sweden (+46) 85-853-65-51 
 
Before contacting Welch Allyn, it is helpful to attempt to duplicate the problem and to check all 
accessories to ensure that they are not the cause of the problem. 
 
When calling, please be prepared to provide: 

 Product name and model number and complete description of the problem 

 The serial number of your product (if applicable) 

 The complete name, address and phone number of your facility 

 For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) 
number   

 For parts order, the required spare or replacement part number(s) 
 
Repairs 
If your product requires warranty, extended warranty, or non-warranty repair service, please 
call first the nearest Welch Allyn Technical Support Center. A representative will assist you 
troubleshooting the problem and will make every effort to solve it over the phone, avoiding 
potential unnecessary return.  
 
In case the return cannot be avoided, the representative will record all necessary information 
and will provide a Return Material Authorization (RMA) number, as well as the appropriate 
return address. A Return Material Authorization (RMA) number must be obtained prior to any 
return. 
 

 Note: Welch Allyn does not accept returned products without an RMA  

  
 
Packing Instructions 
If you have to return goods for service, follow these recommended packing instructions: 

 Remove all hoses, cables, sensors, power cords, and ancillary products (as 
appropriate) before packing, unless you suspect they are associated with the 
problem. 

 Wherever possible use the original shipping carton and packing materials. 

 Include a packing list and the Welch Allyn Return Material Authorization (RMA) 
number. 

 
It is recommended that all returned goods be insured. Claims for loss or damage to the 
product must be initiated by the sender.  
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Limited Warranty Statement 
Welch Allyn, Inc. warrants that the Welch Allyn CardioPerfect Workstation computer based 
product you have purchased meets the labeled specifications of the Product and will be free 
from defects in materials and workmanship that occur within 1 year after the date of purchase. 
Accessories used with the Product are warranted for 90 days after the date of purchase.  
 
The date of purchase is: 1) the date specified in our records, if you purchased the Product 
directly from us, 2) the date specified in the warranty registration card that we ask you to send 
to us, or 3) if you don‟t return the warranty registration card, 120 days after the date on which 
the Product was sold to the dealer from whom you bought the Product, as documented in our 
records. 
 
This warranty does not cover damage caused by: 1) handling during shipping, 2) use or 
maintenance contrary to labeled instructions, 3) alteration or repair by anyone not authorized 
by Welch Allyn, and 4) accidents. 
 
You assume all responsibility for use of the Product with any hardware or software that does 
not meet the system requirements described in the Product documentation. 
 
If a Product or accessory covered by this warranty is determined to be defective because of 
defective materials, components, or workmanship, and the warranty claim is made within the 
warranty period described above, Welch Allyn will, at its discretion, repair or replace the 
defective Product or accessory free of charge. 
 
You must obtain a return authorization from Welch Allyn to return your Product before you 
send it to Welch Allyn‟s designated service center for repair.  
 
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE. WELCH ALLYN'S OBLIGATION UNDER 
THIS WARRANTY IS LIMITED TO REPAIR OR REPLACEMENT OF PRODUCTS 
CONTAINING A DEFECT. WELCH ALLYN IS NOT RESPONSIBLE FOR ANY INDIRECT 
OR CONSEQUENTIAL DAMAGES RESULTING FROM A PRODUCT DEFECT COVERED 
BY THE WARRANTY. 
 
 
 

 

 WARNING 
 

The CardioPerfect devices are an integral part of a personal 
computer based diagnostic system. The user shall adhere to 
warnings in order to ensure safe and reliable performance of the 
system. 

 The personal computer (non-medical electrical equipment) 
shall be situated outside the patient environment 
(reference IEC 60601-1-1). 

 The personal computer used should be approved to the 
appropriate safety standard for non-medical electrical 
equipment (IEC 60950, or its national variants), and use of 
an isolation transformer is recommended. 

If there is a requirement for the personal computer to be situated 
within the patient environment it is the responsibility of the user to 
ensure the system provides a level of safety that ensures 
compliance with IEC 60601-1. 
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Welcome 
Welcome to the Welch Allyn CardioPerfect Exercise ECG module of Welch Allyn 
CardioPerfect Workstation. This module offers you exciting features and provides everything 
you expect from an exercise ECG software package. 
This manual provides the necessary information for the installation, operation and 
maintenance of the Welch Allyn CardioPerfect Exercise ECG recording system. These 
instructions must be studied before putting the unit into operation. 
 
This manual contains specific information about the exercise ECG module of the Welch Allyn 
CardioPerfect Workstation. For all general information about the workstation software please 
refer to the Workstation manual, this describes:  
- Creating and editing Patient cards 
- General information about printing 
 
For further information on installation and configuration or information on servicing please 
refer to the Installation manual and/or the Service and Advanced Installation manual. 
 
Intended use 
Using the optional ECG module and associated accessories, the user can acquire, view, 
store, and print ECG waveforms. 
 
Indications  
Indications for electrocardiography range from routine screening of cardiac health in the 
physician office environment to directed diagnostic differentiation in a hospital cardiology 
department. 
 
Contraindications and precautions 
The following contraindications are known for the recording of an exercise ECG: 

 Recent onset of chest pain, or a change in the pattern of pain to suggest unstable 
angina. 

 Acute myocardial infarction within a week after its onset. 

 The presence of congestive heart failure, excessive hypertension, or severe aortic 
stenosis in adults. 

 Uncontrolled ventricular arrhythmias. 

 Known critical stenosis of left main or proximal coronary artery. 
 
[Ellestad MH, Blohmqvist CG, Naughton JP. "Standards for adult exercise testing 
laboratories."  AHJ A:421A-30A] Since the risk is not negligible, the staff of the exercise 
laboratory should be trained in cardiopulmonary resuscitation. A physician should also be 
present at all exercise tests in patients with suspected or known heart disease. A defibrillator 
and drugs should be immediately available. 
 
Due to summation of leakage currents, it is possibly hazardous to connect several devices to 
the patient simultaneously.  
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1. Getting started 

1.1  The Welch Allyn CardioPerfect Exercise ECG window 
This section will guide you around the various parts of Welch Allyn CardioPerfect Exercise 
ECG.  
 
 
 

  
 
 
 
   
Title bar The title bar displays the name of the program. The title bar contains three 

buttons that you can use to maximize, minimize and close the Workstation 
window. 

  
Menu bar Each menu in the menu bar contains a number of tasks that you can 

perform with Welch Allyn CardioPerfect Exercise ECG. Sometimes, menus 
are gray. This means that you cannot access that functionality at that 
particular point, either because it is not available, or because you are not 
authorized to use it. 

  
Tool bar The tool bar contains buttons that give you easy access to the most 

common tasks in Welch Allyn CardioPerfect. 
  
Search area The search area contains search and display functionality that lets you 

easily retrieve patients and tests. In the search area, you can find a patient, 
see which tests were recorded for that patient and see the kind of tests that 
were recorded. You can also create search patterns, an easy way of finding 
information that you need frequently. 

  
Workspace The workspace is the core part of Welch Allyn CardioPerfect Exercise ECG. 

It displays the exercise ECG in various formats. These formats, that are also 
called views, are each displayed on a separate tab in the Welch Allyn 
CardioPerfect Exercise ECG workspace. The workspace is the place where 
you record, view, compare and measure exercise ECGs. 

  

Menu bar Title bar 

Workspace 

Toolbar Search 
area 

Status bar 

 

Shortcut menu 
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Shortcut 
menu 

In the workspace, you can use shortcut menus to access the most common 
tasks. You can access these tasks by clicking on the workspace with your 
right mouse button. Shortcut menus only contain those tasks that can be 
performed in one specific test or part of that test. As a result, shortcut 
menus look different in different views. 

  
Status bar The status bar shows important information about the patient and test that 

are currently selected. Additionally, the status bar displays the name of the 
user that is currently logged on to Welch Allyn CardioPerfect. 

   

1.2  Structure of an exercise ECG 
An exercise ECG consists of the following elements: 
 

 Phases: the distinct parts of an exercise ECG. In CardioPerfect they are pretest, 
exercise, recovery and posttest. 
 

 Stages: the distinct parts of a phase. For instance, an exercise phase can have 
different stages with different workloads. 
 

 Exercise protocol: a specific set of rules and conventions that determine how the 
exercise ECG is performed. A protocol consists of a number of phases. Each phase 
consists of a number of stages. Welch Allyn CardioPerfect Exercise ECG offers a 
number of well-known protocols that you can use. Additionally, you can create your 
own exercise protocols.   
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2. Recording an exercise ECG 

2.1  The Real-time monitor 
The Real-time monitor is displayed when you start a new exercise ECG. During the test, this 
window allows you to control and monitor all aspects of the test, and review any recorded 
results. 
 

 
 
 
  
ECG traces The leads of the ECG. You can select different lead configurations 

(1x12, 2x6, 4x3) from the shortcut menu.  With the shortcut menu 
you can also adjust the chart speed and the sensitivity. 

  
Dividers The dividers in the ECG traces area can be switched on or off from 

the shortcut menu. 
  
Average complexes The area to the right of the ECG traces displays the average 

complexes.  
 
Options available form the shortcut menu: 

 Marker option on or off. If the Markers option is enabled the 
ST measurements are displayed next to the Average 
complex. 

 The Slope option displays the Slope value next to the 
Average complex if the Markers option is enabled. 

 The reference complex can be displayed on top of the 
Average complex. 

 The current complex can be set as reference. 
  
Note: If square waves are displayed the signal on one or more of the channels is erroneous 

see section 2.3.10 on page 25 for more information. 
  

ECG traces 

Tabs 

Overview area 

Tabs 

Button bar 
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Button bar 
Start/stop button With the Start (stop) button, you start (stop) an ECG recording. 
  
Next phase The Next phase button displays the name of the next phase for 

example Go to recovery. With it you move to the next phase in 
the exercise protocol. 

  
Next stage The Next Stage button displays the name of the next stage. 

With it you move to the next stage of the current phase in the 
exercise protocol. 

  
Hold stage With the Hold stage button you can force the protocol to remain 

in the current stage. 
  
Change load With the Change load button you can change the load for the 

treadmill or bicycle.  
  
Perception button A record of patient perception for several parameters can be 

added to the test with the Perception button 
  
Blood pressure button With the Blood pressure button, you can enter a blood 

pressure measurement at any time. Blood pressure can be 
measured manually or automatically. This depends on the blood 
pressure device. 

  
Comment button With the Comment button, you can add information to the 

exercise ECG, like a description of an arrhythmia that has 
occurred. 

  
Event button With the Event button, you can indicate an event, like 

arrhythmia. When you click the button, Welch Allyn 
CardioPerfect Exercise ECG inserts a mark in the full disclosure 
view, and adds the event to the event list.  The Event button 
functions similar to the Comment button, but additional 
information cannot be added. 

  
Print button With the Print button, you can print a report. See 7.3.1 on how 

to select the report format. 
  
Emergency stop With the Emergency stop button, you can stop the exercise 

device. The monitoring of the patient will continue. See page 15 
for important information regarding the Emergency stop 
function. 
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Overview area 
Overview area In the Overview area, you can find the following information 

about the exercise ECG: 

 Phase of the exercise ECG (monitoring, exercise, 
recovery) and the duration of the phase. 

 Number and name of the Stage that is currently being 
recorded 

 The current heart rate of the patient and the current 
heart rate as a percentage of the maximum predicted 
heart rate. 

 VES: the number of VES beats (Ventricular Extra 
Systole) per minute. 

 The current blood pressure and previous blood 
pressure are displayed. 

 The current workload and the current workload as a 
percentage of the maximum workload. The maximum 
workload is calculated based on the last valid stage. By 
default the minimum stage duration is 30 seconds. 

 The RPM is displayed when an ergometer is used. 

 The protocol that you selected at the start of the test. 
 
 The following variables can be set: 

 Speed [mm/sec] and sensitivity [mm/mV].  

 Pacemaker on/off. ECG traces can contain artificial 
pacemaker signal indicators. You can remove this 
artificial pacer indicator by disabling the "Show Pacer" 
selection. To learn how, see Exercise ECG settings- 
General tab on page 48. 

 Baseline filter on/off. ECG traces can contain some 
baseline wander caused by movement. You can reduce 
this wander of the baseline by applying a baseline filter.  

 Muscle filter on/off. Muscle noise in an ECG signal 
hides low amplitude signals that may be important for 
the interpretation of an ECG. You can remove this noise 
with a muscle noise filter. 

 
After switching to the recovery phase, the total exercise time, the maximum heart rate, the 
maximum workload, the protocol name, and the current METS values are displayed. 
 

Tabs below the ECG traces: 
Trends tab The Trends tab contains the event list and three curves: 

 Workload against time 

 Heart rate against time. The VES (ventricular extra 
systole) count can be displayed in the Heart rate graph 
from the shortcut menu. 

 Blood pressure against time. The RPP (Rate Pressure 
Product) can be displayed in the Blood pressure graph 
from the shortcut menu. 

  
History tab The History tab shows the history of all twelve leads. Here, you 

can move back in time, or print a view, while the exercise ECG 
recording continues. Clicking the double arrow buttons moves 
forward and backward from event to event. 
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Tabs below the ECG traces: 
ST/Slope tab This ST/slope tab shows the comparison between the actual 

and referral ST measurement. The arrows below give the 
direction of the slope. 

  
Test Information General information about the test including for example the 

reasons for the recording, the type of test and cardiac risk 
factors can be added in the test information tab. 

  
Test observations Observations made during and prior to the recording, including 

for example the symptoms during stress, baseline ECG results 
and reasons for test termination can be added in the test 
observations tab. 

  
Interpretation tab In the Interpretation tab you can add an interpretation and 

comments like reasons for stopping the test. You can start 
adding comments while the test is still in progress. 

 
  

Tabs to the right of the ECG traces: 
ST tab The ST tab displays trends for the measured ST and ST slope 

against time. You can display three leads at a time, and select 
which leads you want to see. 

  
Table tab The Table tab displays an overview of the last measured ST 

values, the value for the reference ST and the resulting ST 
deviation for each lead. The highest deviation values are 
displayed in bold red text. Below the ST values, the lead with 
the highest ST elevation or depression is displayed. 

  
Complex tab The Complex tab displays the average complex of a lead. You 

can select which lead should be displayed. 
  
Shortcut menu The shortcut menu provides a variety of controls depending on 

the tab which is active, including setting the ST point and the 
display of the Slope values.  

  
 

2.2  Record an exercise ECG 
Welch Allyn CardioPerfect Exercise ECG records exercise ECGs easily and reliably. The only 
thing you have to do is make sure the electrodes are placed correctly and switch on the 
recorder. Welch Allyn CardioPerfect Exercise ECG takes care of recording, adjusting the 
ergometer or treadmill, making a number of measurements and calculations, taking blood 
pressure readings and saving the recording. 
 
To record an exercise ECG, you need to follow these global steps. Each step is explained in 
more detail on the following pages. 
 
To record an exercise ECG: 

1. Place electrodes on the patient. 
 
Important:  Because Welch Allyn CardioPerfect Exercise ECG is a 12 lead 
electrocardiograph all electrodes must be connected! Proper skin preparation 
(abrasion if necessary) and proper electrodes are essential for a good signal quality. 
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2. In the Workstation, select or create a patient. 

3. Create a new exercise ECG. The Real-time monitor is displayed. Depending on the 
ECG recorder used, Welch Allyn CardioPerfect may ask you to switch on the 
recorder. 

4. If prompted, switch on the recorder. If a Welch Allyn CardioPerfect Pro recorder is 
used no message will appear, the recorder will be switched on automatically. The 
Real-time monitor displays the ECG traces. 

5. Adjust the real time display to your requirements. 

6. In the Real-time monitor, wait until the signal is stabilized and click the Start button to 
start recording. Welch Allyn CardioPerfect Exercise ECG automatically starts the first 
phase and stage of the test protocol. 

7. During the test, you can: 

 Measure the blood pressure 

 Add patient perception parameters 

 Capture an event 

 Add a comment 

 Turn pacemaker mode on or off 

 Apply a baseline filter to filter out baseline wander 

 Apply a muscle filter 

 Change or hold the current load 

 Print a variety of reports 

8. To move to the next phase of the test, click the button that displays the name of the 
next phase. 

9. When you have reached the end of the test, click the Stop button to stop the test. 
Welch Allyn CardioPerfect Exercise ECG may ask you to switch off the recorder. If a 
Pro recorder with USB connection is used the recorder will be switched off 
automatically, no message appears. Welch Allyn CardioPerfect Exercise ECG 
automatically saves the exercise ECG and displays it on your monitor. 

10. Disconnect the patient.  

 
Important: In case of an emergency the test can be stopped with the Emergency Stop 
button. Welch Allyn CardioPerfect will then continue monitoring the patient, but all connected 
exercise devices will be stopped immediately. Printouts can still be made and the operator 
can still enter comment and user events when the Emergency Stop is engaged. All other 
functions are disabled. Click the Stop button to stop monitoring the patient. Welch Allyn 
CardioPerfect Exercise ECG automatically saves the exercise ECG and displays it on your 
monitor.  
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2.2.1. Place electrodes on the patient 

When you connect the electrodes to the patient, make sure that the electrodes and their 
connectors (also the RL/N electrode) do not contact other conducting parts (including earth). 
 
Connect the electrodes in the following positions: 
   

AHA IEC 
  

V1 Fourth intercostal space at the right border of the sternum. C1 

V2 Fourth intercostal space at the left border of the sternum. C2 

V3 Midway between locations V2 and V4. C3 

V4 At the left mid-clavicular line in the fifth intercostal space. C4 

V5 
At the left anterior axillary line on the same horizontal level as 

V4. 
C5 

V6 
At the left midaxillary line on the same horizontal level as V4 

and V5. 
C6 

RA On the right, below the clavicle or above the crista scapulae. R 

LA On the left, below the clavicle or above the crista scapulae. L 

RL 
Right, just above the spina iliaca superior posterior  

or the crista iliaca. 
N 

LL 
Left, just above the spina iliaca superior posterior  

or the crista iliaca. 
F 

 
 

2.2.2. Select or create a new patient 

See the Welch Allyn CardioPerfect Workstation user manual for detailed information on 
selecting or creating a new patient. 
 

2.2.3. Create a new exercise ECG 

Before you can record an exercise ECG, you first need to create a new ECG in Welch Allyn 
CardioPerfect. When you do this, you will be able to set the target heart rate, and the 
exercise, blood pressure and print protocols. You can also identify the physicians associated 
with the test and enter a variety of test data and information. 
 

LL 

V1 V2 
  V3 
   V4    V5    V6 

RA LA 

RL  N  F 

C1 C2 
  C3 
   C4    C5    C6 

R                     L                
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To create a new ECG: 

1. In the File menu, point to New and click Exercise ECG. The New exercise ECG 
dialog box is displayed. Click on the General tab. 
 

 
 
 
In the Test area, enter the target heart rate or enter the target heart rate as a 
percentage of the predicted maximum heart rate, see also page 26. For ergometers, 
you can also enter the target workload, see also 2.3.13 Target Workload. 

2. In the Test area select the names of the referring, ordering, and attending physician, 
see also page 18.  

3. Go to the Protocol area to select the protocols that you want to use: 

 In the Protocol area, select the exercise protocol that you want to use. You can 
choose from a number of predefined protocols. 

 Select a Blood pressure protocol to indicate how you want to measure the blood 
pressure during the test.  

 Select a Print protocol to indicate whether reports should be printed automatically 
or not. 
 
For more information on protocols, see page 58. 
 

Target workload 
only applicable for 
Ergometers 
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4. Test information and test observations: 
 

  
Click on the Test information tab to add 
general information about the test, 
including for example the reasons for the 
recording and risk factors. 

Click on the Test observation tab  to 
add information 

  
Select a keyword from the left pane, then select a value from the picklist in the right 
pane. If other is selected, free text can be entered in the entry box below the picklist 
 

5. In the Interpretation tab, you can enter comments, by using either the predefined 
statements in the left hand pane or by simply typing in the right hand pane. Click on 
the save button to save these entries with the test. 
 

 
 
Note: Unconfirmed interpretations can continue to be edited during and after the 
test. Once the interpretation has been confirmed by a physician with the save and 
confirm button, the test can only be edited by a user with confirm interpretation 
rights. For more information see the Administrator Tool. 
 

6. Click OK. 
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2.2.4.  Add Physicians to the test 

With Welch Allyn CardioPerfect workstation you can link the names of three types of 
physicians to an exercise test: 

 Referring physician 

 Ordering physician; the physician that ordered the test 

 Attending physician; the physician that is supervising the test. 
 

You can add the names of the physicians in the New exercise ECG dialog. Click on the    

button to select a name from a list of most recently selected physicians. Click on the  
button and a more extended list of physicians will appear. 
 

  
 
In this window you can select a specialty and then select a physician from the list. You can 
also add a new physician. 
 
To add a new physician: 

1. Click on the  button next to the physician in the New Exercise ECG window. 

2. Click on the Add button in the Select physician window. 

3. Select a specialty and enter the last name.  

 

4. Click on the OK button. 

5. Click on the OK button to return to the New Exercise ECG window. 

 
 Note:  You can still add or edit the names of the physicians in review mode if the test is not 

confirmed yet. Select Edit test from the action menu.  
A specialty can only be added with the Admin tool.  
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2.3  Real-time monitor 
   

You are now ready to record the test. In the Real-time monitor, click the Start 
button to start recording.  After the Start button is pressed, it will change to a 
Stop test button.  

Welch Allyn CardioPerfect Exercise ECG automatically starts the first phase 
and stage of the test protocol and moves automatically to the next stage 
according to the test protocol. To move to the next phase or stage manually, 
click the button that displays the name of the Next phase or stage.  
 

 
 

 
When you have reached the end of the test, click the Stop test button to stop 
the test. Welch Allyn CardioPerfect Exercise ECG will ask you to switch off 
the recorder. Welch Allyn CardioPerfect Exercise ECG automatically saves 
the ECG. 
 

 

In case of an emergency you can also use the Emergency stop button (or 
F12) to stop the test. Welch Allyn CardioPerfect will immediately stop the 
exercise device. The monitoring of the patient will continue and printouts can 
be made. 

 

   
 
During the test, you can: 

 Measure the blood pressure 

 Capture an event 

 Add a comment 

 Turn pacemaker mode on or off 

 Apply a baseline filter to filter out baseline wander 

 Change the load 

 Pause the protocol 

 Print a report 
 
 

2.3.1. Select how you want to view leads 

Once you have created a new exercise ECG, the Real-time monitor displays the ECG traces. 
Before you start the actual recording, you can select how you want to view the traces. Welch 
Allyn CardioPerfect Exercise ECG offers different views, different chart speeds and different 
sensitivities. 
 
To select a different view: 

 In the View menu, point to Monitor style and click a value. You can choose between 
3, 6 or 12 simultaneous leads. The new view is immediately displayed. 

  
To arrange the leads in 3-lead and 6-lead views: 

 Click on the tabs under the traces to display different lead groups. 
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To select a different chart speed for the view: 

 In the Overview area, above the ECG traces, select a value [mm/sec] from the drop-
down list. The new speed is immediately displayed. 

 
To select a different sensitivity for the view: 

 In the Overview area, point to Sensitivity and select a value [mm/mV] from the drop-
down list. The new sensitivity is immediately displayed. 

 
Note: The options above are also available from the shortcut menu. 
 

2.3.2. Measure blood pressure 
You can measure the patient's blood pressure during the recording in two ways: 

 Manually: you press the blood pressure button yourself, measure the blood pressure, 
and enter the values. 

 According to protocol: the blood pressure is measured according to a protocol defined 
in the protocol editor or a default protocol (“Automatic”). The Automatic protocol 
initiates a blood-pressure measurement on every load-change.  A blood pressure 
protocol can either initiate the blood pressure measurement at predefined intervals or 
by following the exercise protocol – for more information see page 59. 

 
You select the blood pressure method when you create a new exercise ECG.  
Whether blood-pressure values must be entered manually, or are measured and saved 
automatically, depends on the type of Blood-pressure device that‟s being used. 
A number of automatic blood pressure devices can be controlled by the Welch Allyn 
CardioPerfect Workstation. 
 
If a device is being used that is not controlled by the Workstation: 

1. Measure the blood pressure. 

2. Click the Blood pressure button.  The Blood pressure dialog box is 
displayed. 
 

 
 

3. If a blood-pressure protocol is used, the dialog box appears automatically, so that you 
know a measurement should be performed. Enter the blood pressure values. 

 
If a device is being used that is controlled by the workstation: 
 

1. A measurement is started automatically according to the protocol (if selected) or by 
pressing the blood-pressure button. 

2. The values are automatically stored with the test.  

 

2.3.3. Capture an event 

Welch Allyn CardioPerfect Exercise ECG can automatically recognize a number of 
arrhythmias. The arrhythmias that can be detected are: 

 Ventricular fibrillation 

 Ventricular tachycardia 
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 Bigemini 

 Triplet 

 PVC run 

 Couplet 

 Arrest 
  
When Welch Allyn CardioPerfect Exercise ECG detects an arrhythmia, an event is created 
that displays the time of occurrence and a description of the arrhythmia. The event is 
displayed in the event list, see 7.2 for more information on configuring which events will be 
displayed or printed. 
 
You can also capture events yourself. When you do this, a mark is inserted at the place 
where the event occurred, and the event is added to the event list. 
After recording, you can edit or expand the description of the event. 
 
To capture an event: 

1. Start a recording. 

2. When an event occurs, click the Event button.  
 

 

   
To edit events after recording: 

1. In the Action menu, click Edit events. The Event list is displayed. 
 

 
 

2. In the Event list, select the event that you want to edit and click Modify. 

3. Select a description from the list, or type a new comment. 

4. Click OK. The description is added to the event. 

 

2.3.4. Patient Perception Parameters 

During recording you can add comments about the perceived exertion, dyspnea and chest 
pain using Borg scales. These scales developed by Gunnar Borg are general scales to 
quantify perceptions and experiences. 
 
To add a perception parameter: 

1. Click the perception button  in the Real time monitor. 

2. In the add event dialog select one of the following parameters: 

a. Dyspnea 
b. Chest pain 
c. Perceived exertion 

3. Directly enter the value or use the slider to set the value. Click the OK button to add 
the information to the test. 
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Depending on the type of event, the following dialog will appear: 
  

Dyspnea and Chest pain 

 
The Borg CR10 scale is used to add 
dyspnea and chest pain parameters to the 
test. 

Perceived exertion 

 
The Borg RPE scale is used to add Patient 
Perceived Exertion to the test. 

 
 0 Nothing at all 
 0.3  
 0.5 Extremely weak 
 0.7 
 1 Very weak 
 1.5 
 2 Weak 
 2.5 
 3 Moderate 
 4 
 5 Strong 
 6 
 7 Very strong 
 8 
 9 
 10 Extremely strong 
 
 * Absolute maximum 

 
 6 No exertion at all 
 7 
 8 
 9 Very light 
 10 
 11 Light 
 12 
 13 Somewhat hard 
 14 
 15 Hard (heavy) 
 16 
 17 Very hard 
 18 
 19 Extremely hard 
 20 Maximum exertion 

 

 
 

2.3.5. Duke Treadmill Score 

 
The Duke Treadmill Score (DTS) is shown in the Summary tab if selected. See page 55 for 
more information on selecting the DTS and section 15 for more information on the DTS 
calculation. 
 
Note: The Duke Score is not applicable for pharmacological stress testing; it is only 

applicable if the selected exercise device is physically used.  
The Duke Score is not calculated if the Test type is not “Exercise” 

 
 

2.3.6. Add a comment 

During recording, you can make notes about, for example, the state of the patient. You can 
choose from predefined comments or type in your own comment. 
 
To add a comment during recording: 

1. Click the Comment button in the Real-time monitor.  

2. In the Comment dialog box, either use the arrow to select a comment from the list or 
type in your own comment. 

Extremely light 
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2.3.7. Apply filters 
Baseline filter 
ECG traces can contain baseline wander that disturbs the signal. You can use the baseline 
filter to filter out this disturbance. When you use the baseline filter, the recorded signal is not 
changed. You only change the way the signal is displayed and printed. 
 
To filter out baseline wander during recording: 
In the Real-time monitor, check the Baseline option in the Overview area or press F3. The 
filter is immediately applied. Clicking the button once more switches the filter off. 

 Alternatively, in the Action menu, click Baseline to switch on the Baseline filter. 
Clicking the option once more switches the filter off. 

 
The baseline wander filter introduces a delay of 3 seconds before data are shown on the real-
time display.    
 
To filter out baseline wander during viewing: 

 In the Action menu, click Baseline to switch on the Baseline filter. Clicking the option 
once more switches the filter off. 

 
 
Note: If accurate ST segment contours are required for ECGs, do not use the 0.5 Hz 

baseline wander filter. This filter suppresses baseline wander to the extent that it may 
alter the ST segment. Instead, configure your cardiograph to operate without the 
baseline wander filter. Regardless of the filter used, the rhythm characteristics of the 
ECG are accurately recorded.  

 
 
Muscle noise filter 
Muscle noise in an ECG signal hides low amplitude signals that may be important for the 
interpretation of an ECG. You can remove this noise with a muscle noise filter.  
 
To apply a muscle noise filter:  

 At the top of the Real-time monitor, click Muscle filter. Click again to switch the filter 
off. 

 

2.3.8. Manual load change  
During recording, it is possible to change the load by clicking the 'Change load' button. 
Clicking this button will open the „change load‟ dialog window which is always on top. 
 
If a treadmill is used the speed and elevation can be changed, if an ergometer is used the 
workload can be changed.  
 
When the „pause the protocol after change‟ option is enabled, the protocol will hold at the 
current load. The pause protocol checkbox is linked to the pause button on the monitor form. 
Clicking either one of them will automatically change the state of the other one.   
 
New values can be entered directly or via the up/down buttons. It is also possible to 
increment/decrement the value by using dedicated keyboard keys, see table.  
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 Load change  

Change
  

Keyboard 
keys 

Treadmill Increment/ 
decrement 

Ergometer Increment/ 
decrement 

 [CTRL + ↑] Elevation + + 1% Load + + 5 Watt 

 [CTRL + ↓] Elevation - - 1% Load - - 5 Watt 

 [CTRL + →] Speed + + 0.1 km/h N/A 

 
[CTRL + ←] Speed -  - 0.1 km/h N/A 

 
When a key combination is pressed, e.g. [CTRL+↑], when the load change window is not 
visible, the load change window will pop-up and the corresponding load will change.  
 
 

 When the 'Instant manual load changes' option is enabled (Exercise ECG settings, 
Devices tab), changes of the load are instant and confirmed. 

 
The change workload window will have the following appearance: 
 
Ergometer : Treadmill : 

 

 
 
Upon changing, the values will immediately be sent to the exercise device. 
 

 When the 'Instant manual load changes' option is NOT set, the form has the following 
characteristics:  

 
Ergometer : Treadmill : 

 

 
  
When OK is pressed, the new values will be sent to the device. When Cancel is pressed, 
changes are ignored and the dialog window will close. 
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2.3.9. Pacemaker pulse detection 

The Welch Allyn CardioPerfect software is able to display pacemaker pulse spikes detected 
by the hardware. These spikes are marked with a symbol in the Real time monitor, in Review 
mode and on printouts.  
 
When the Pacemaker pulse detection is on, the detected spikes are marked on the trace, as 
shown here. To learn how to disable this function to remove artificial pacemaker signal 
indicators, see “Show Pacer” under Exercise ECG settings- General tab on page 48. 
 
 

 
Pacemaker markers 

 

2.3.10. Signal quality indication 

 
If CardioPerfect Workstation finds the signal from one of the channels to be erroneous, for 
example from a disconnected electrode, the monitor will show “Bad signal on…”.  The trace 
displays square waves, see example below. 
 
 
 

 
 
 
Please check the indicated electrodes immediately! 
 
The status information is saved with the test. Erroneous leads will show square waves on 
both the Review and the printout. Depending on the duration of the erroneous signal no 
measurement may be possible and therefore may not be shown. 
 

Square waves 
 

Warning in red 
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In the few moments between a lead being disconnected and that event being detected by the 
software, pacemaker spikes may be erroneously detected. As a result, a group of pacemaker 
markers may be shown on the trace just before the square waves are shown. The pacemaker 
pulse detection will be suppressed as soon as the square waves are shown, and will continue 
to be suppressed until the erroneous signal is corrected. 

 

2.3.11. Printing during recording 

You can print the following formats while recording an exercise ECG: 

 2x6 simultaneous or sequential 

 4x3 simultaneous or sequential 

 rhythm 
 
To print during recording: 
In the Real-time monitor, click the Print button. It may take some time for the copy to be 
printed, especially with slow printers. The Print format that is selected in the settings will be 
printed. 
  
Tip for printing during recording: 
If you frequently print during recording, you might want to consider Automatic printing. With 
Automatic printing, you can configure Welch Allyn CardioPerfect Exercise ECG to print at set 
times during the recording. 
 

2.3.12. Target heart rate 
The Real-time monitor displays the current Heart rate and the target Heart rate during 
recording, in the overview area.  
 

 
  

The target Heart rate can be adjusted at the start of a new exercise ECG.  
 
You can either set the target Heart rate directly, or set it as a percentage of the predicted 
maximum Heart rate. By default the target Heart rate value is set as 85% of the predicted 
maximum HR. 
 
The predicted maximum Heart rate is calculated with the following formula: 
 

Predicted Maxium Heart Rate = (220 - patient's age in years) 
 
Welch Allyn CardioPerfect displays the Predicted Maximum Heart Rate next to the Target 
Heart rate field when the new exercise dialog window is opened.  
 

  
 
To set the target Heart rate: 

Enter a value in the Target Heart rate field. 
 
To set the target Heart rate as a percentage of the maximum Heart rate: 

Enter a percentage in the corresponding field. 
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2.3.13. Target Workload 

If an Ergometer was selected as exercise device, the Real-time monitor displays the current 
Workload and the current Workload as a percentage of the Target Workload during recording, 
in the overview area.  
 

 
  

The Target Workload can be adjusted at the start of a new exercise ECG in the New Exercise 
ECG window.  
 

 
 

 
The Standard Target Workload shown is calculated with the following formula: 
 

Target Workload = ((2 * Height) - (2.37 * Age) - 73) * 1.01 + 16.6 
 
In case of a female patient multiply the above by 0.8. 
 
Units: 
The height is specified in centimeters. 
The Age is specified in years. 

 
 
To set the Target Workload: 

Enter a value in the Target Workload field. 
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3. Viewing an exercise ECG 

3.1  About viewing exercise ECGs 
Welch Allyn CardioPerfect Exercise ECG offers various views on an exercise ECG. Each 
view highlights a different aspect of the ECG. You can have a look at all twelve leads in full 
disclosure, 2x6 and 4x3 format, but you can also view the test results in a summary report. 
Additionally, you can view the average complexes for each lead, the ST levels and slopes, 
evolution of the patient's heart rate and a number of trends. Each view is presented on a 
different tab in the workspace and has different functionality. 
 

3.2  View an exercise ECG 
To view an exercise ECG: 

1. Select a patient. The tests that have been recorded for that patient are listed in the 
test list. 

2. From the test list, select the ECG that you want to see. ECGs are indicated with . 
Welch Allyn CardioPerfect Exercise ECG is started automatically, and the test is 
displayed in the workspace. 

 

3.2.1. Zoom in and out on an exercise ECG 

If you want to get a closer look at the traces, you can adjust the size of the leads by zooming 
in and out of the exercise ECG. You can adjust the size of the leads by zooming in and out of 
the exercise ECG.  
 
To see leads in more detail: 

 In the View menu, click Zoom in. 
 
To see a larger part of the ECG: 

 In the View menu, click Zoom out. 
 
To reset the zoom function and return to the standard size: 

 In the View menu, click Reset zooming. 
  
Tips for zooming in and out on an ECG: 
You can also use your right mouse button for zooming. 
 

3.2.2. Set chart speed and sensitivity 

Welch Allyn CardioPerfect Exercise ECG offers a wide range of speed and sensitivity. You 
can adjust the scale of an exercise ECG by adjusting the chart speed and the sensitivity.  
 
To set the chart speed: 

 Right click on the view, point to Speed and select a value.  
 
To set the sensitivity: 

 Right click on the view, point to Sensitivity and select a value. The lower the value, 
the lower the lead signal amplitude will be.  
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3.2.3. Navigate through recording time 

You can move through the recording time of an exercise ECG in a number of ways.  
 
Scrolling: with the vertical scroll bar at the right side of the window, 
you can move through the entire recording. 
   
Binoculars icon: if you move the mouse over the binoculars, a 
selection of global events is displayed. If you click on one of these 
events, you are automatically taken to that point in the recording.  The 
content of the binocular list is determined by Selections, which are 
configured in File-Setting-Exercise ECG-Viewing.  See page 49 for 
more information. 
  
 
 
 
 
 
 
Select the parts of the test you want to view 
When you view the exercise ECG, you can go through the recording time in a number of 
ways. You can, for instance, scroll through the entire recording. But you can also view the 
recording time in a summary that only includes a number of events. This option quickly takes 
you through the important parts of the test. 
 
To select the parts of the test that you want to view: 

 In the Selection list that is present on the Averages, Full disclosure, 2x6, 4x3 and ST 
table views, click on a selection.  

 
To view a part of the selection: 

 Point to the binoculars icon. A list with times and events is displayed. If you click on 
one of the events, you are automatically taken to that point in the recording. 

 
Tips for making selections: 

 You can configure the items in the Selection list in the exercise ECG settings (please 
refer to page 51 to read how to do this). 

 

3.2.4. Copy into other applications: 

A bitmap of the Averages view, the Full Disclosure view, the 2x6 and 4x3 view and the text of 
the ST table can be copied into other MS windows applications. Select the view you want to 
use and right click on the view and select copy. You can now paste the bitmap for the graphs 
or the text for the ST table into other MS windows applications.  
 
 

3.2.5. Post-test editing of tests 
The information added in the New Exercise ECG dialog is editable as long as the 
interpretation is not yet confirmed. 
 
To edit an unconfirmed test: 

 Select Edit test from the Action menu or click on the   button in the 
Toolbar. Select the Test Information, Test Observation or Physicians tab to edit the 
test information. Click save to save the information with the test. 
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3.3  Work with the Summary view 
Summary view 
The summary view displays a report with the most important information, measurements and 
results. The default summary view can be adjusted to your own preferences from the settings 
menu. See page 55 for more information. 
 

 
  
The default summary view consists of: 

Patient information The name, number, birth date, gender, height and weight of the 
patient. 

  Test information Information about the reasons for the test, test type, medications and 
cardiac risk factors. 

  

Test results Information about: the test date, duration, device, the used protocol, 
the length, duration and number of stages of the various phases, 
target heart rate, maximum heart rate, maximum blood pressure and 
maximum workload.  The name of the technician, as well as the 
names of the referring, ordering and attending physicians, are also 
shown in this section. 

  Test observations Observations made during the test like: symptoms during the test, 
heart rate and blood pressure response to exercise, reasons for 
testing. 

  Interpretation If the exercise ECG has been interpreted, this section contains the 
interpretation statements. 
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Trends and Graphs 

ST table An overview of the ST values as calculated in the ST table 
view. 

  
Heart rate trend The heart rate trend as calculated in the Heart rate view. 

  
ST trend The ST value chart of a predefined lead 

  Blood pressure The blood pressure, heart rate and corresponding rate 
pressure product. 

 

3.4  Work with the Averages view 

3.4.1. Averages view 

The Averages view displays the averaged complexes at a number of given points in the 
exercise ECG. These points usually are the ends of each stage, and points of interest, such 
as the highest ST deviation. See section 7.2.1 for more details about configuring Selections. 
 

  
 
For each point, the averaged complexes of six leads are displayed, together with the patient's 
heart rate, the QRS duration, the workload (in case of an ergometer test) or speed and 
elevation (in case of a treadmill test), the phase and the blood pressure. The ST levels and 
slopes are displayed above the complexes. 
 
To select which six leads you want to view: 

1. Click the I-aVF button to display the averages of leads I to aVF. 

2. Click the V1-V6 button to display the averages of leads V1 to V6. 

3. Click the I-III,V1-V6 button to display the averages of leads I to V6. 

4. Click the Favorites button to display the lead preference that was set in the exercise 
ECG settings. 

 
To display multiple rows with averaged complexes: 

1. Click the right mouse button on the view to display the contextual menu. 

2. Click Number of Rows. The Rows dialog box is displayed. 

3. Enter the number of rows you want to see. 
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3.4.2. Display markers 

Markers indicate where in the QRS complex the measurement reference points have been 
set. These reference points are automatically calculated, but they can be modified. You can 
use a marker as a starting point for your observations or measurements. Markers can only be 
displayed in the Averages tab. 
Welch Allyn CardioPerfect Exercise ECG shows markers at the following points: 

 Q QRS onset 

 J QRS end 

 J+x ST measurement point 
 

To display markers: 

 In the Averages view, click with your right mouse button and select Markers. Click 
once more to hide the markers again. 

 
Tips for displaying markers: 

 You can change the color of the markers in the exercise ECG settings. 
 
 

3.4.3. Make measurements 
In each view that displays leads or complexes, you can make measurements between two 
points.  
 
To make a measurement between two points: 

1. Move the crosshair pointer to the starting point of your measurement. 

2. Double click on the starting point. Welch Allyn CardioPerfect Exercise ECG inserts a 
mark. 

3. Move the crosshair pointer to the end point of your measurement. 

4. Double click on the end point. Welch Allyn CardioPerfect Exercise ECG draws a line 
between the two points and displays the measured values. 

 
You can remove these measurements by selecting Refresh from the Action menu or 
pressing Ctrl + R. 

 

3.4.4. Set reference complex 

In the Averages view, you can set a reference complex that can be used for comparison. 
 
To select a reference complex: 

 Select a phase from the Reference complex list. If you do not want to see a reference 
complex, select None. The reference complex is displayed in the Averages view as a 
red curve. 

 

3.4.5. Compare averages with full disclosure data 
When the average complexes show unexpected results, it is worthwhile to compare the 
computer-generated data in the Averages view with the actual data in the Full disclosure 
view. With Welch Allyn CardioPerfect Exercise ECG, you can move between identical points 
in time in the Averages view and the Full disclosure view. The point that you select in the 
Averages view is displayed in the Full disclosure view. 
 
To compare an average with its full disclosure data: 



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  33 / 83 

1. In the Averages view, click your right mouse button on the average that you want to 
compare. 

2. In the shortcut menu, click Go to Full disclosure. The Full disclosure view opens at 
the same point in the recording that you clicked in the Average view. 

 
To switch from full disclosure data to averages: 

1. In the Full disclosure view, click your right mouse button on the point that you want to 
see in the Averages view. 

2. In the shortcut menu, click Go to Averages. The Averages view opens and displays 
the complex that is closest to the point you selected in the Full disclosure view. 

  

3.4.6. Change QRS onset and QRS end markers 

Welch Allyn CardioPerfect Exercise ECG automatically inserts markers at the QRS onset (Q), 
QRS end (J) and J+ of an average complex. You can change the position of these markers 
(so that they are more to your liking) in the Averages view. 
The J+ marker follows the QRS end marker according to the set value for the reference point 
value in the Exercise ECG settings. 
 
To change the QRS onset and QRS end markers: 

1. In the Averages view, right click on the view and select Edit from the shortcut menu. 
The Edit average complex dialog box is displayed. 

2. From the list in the left hand corner, select the lead you want to be displayed during 
editing. 

3. Move your mouse over the markers until the cross hair pointer changes shape. 

4. Click your left mouse button and keep it pressed, and drag the marker to adjust. 
 
Note: You can select an aimer from the right click menu as a positioning aid. 

 

3.5  Work with the Full disclosure view 

3.5.1. Full disclosure view 

The Full disclosure view displays the complete 12 lead recording. This view is very 
convenient for reviewing any arrhythmias that may have occurred during the recording.  
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The Full disclosure view displays the following events with a marker: 

 Blood pressure measurements 

 Phase or workload changes 

 User events 

 Comments 

 Arrhythmias (optionally, see 7.2 to configure) 
  

3.5.2. View leads 
To view one lead: 

 Click on the button of the lead you want to view. 
 
To view workload changes: 

1. Click your right mouse button to display the shortcut menu. 

2. Click Workload changes. The workload changes are displayed in the view. Click 
once more to hide them again. 

  

3.5.3. Insert events after recording 
When you scroll through the Full disclosure view and want to make note of an arrhythmia or 
other event, you can still insert this after recording. 
 
To insert a user event after recording: 

1. In the Full disclosure view, click your right mouse button to display the shortcut menu. 

2. In the shortcut menu, click Insert user event. The Enter comment dialog box is 
displayed. 

3. Select a predefined comment from the list, or type a new text. 

4. Click OK. 
 
The user event will appear where the crosshair cursor has been positioned. 

 

3.5.4. Use filters 

When viewing full disclosure, or any other waveform report, the filter settings used during the 
recording are not automatically applied during review. You must choose whether the filters 
should be applied to the data being reviewed.  When viewing the full disclosure you can use 
two filters: 

 Baseline filter 

 Muscle filter 
 
Both filter options can be found in the Action menu. Select the appropriate filter to enable it. 
The filter option will be marked with a check. To disable the filter simply select it again. 
 
Note: When you enable a filter from the Action menu it will also affect the 2x6 and 4x3 view. 
 
Note:  You can tell which filters are enabled in the portion of the full disclosure, 2x6, and 4x3 

views by looking at the frequency response displayed.  If the baseline filter is 
enabled, the lower frequency will be 0.5Hz.  If the muscle filter is enabled, the upper 
frequency will be either 25 or 35 Hz (depending on the settings). 

  
If accurate ST segment contours are required for ECGs, do not use the 0.5 Hz baseline 
wander filter. This filter suppresses baseline wander to the extent that it may alter the ST 
segment. Instead, configure your cardiograph to operate without the baseline wander filter. 
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Regardless of the filter used, the rhythm characteristics of the ECG are accurately recorded 
and do not affect the interpretation algorithm.  

3.6  Work with the 2x6, 4x3, and Rhythm views 
 
2x6 view 
The 2x6 view displays the 12 leads in two columns and six rows. This is a convenient format 
for comparing leads at specific points in the test, such as the end of stages, the point where 
the maximum ST level, the highest blood pressure or the highest workload were measured. 
The view can be simultaneous or sequential, selectable from the shortcut menu. 
 
4x3 view 
The 4x3 view displays a 12 lead-ECG strip. The leads are shown in a 4x3 configuration with a 
rhythm strip at the bottom of the view. The view can be simultaneous or sequential. 
The rhythm lead can be set in the general XECG settings. 
 
 

Rhythm view 
The Rhythm view displays leads in different groupings, so that you can easily switch between 
the most common groups. 

3.6.1. Use filters 

When viewing the 2x6 or 4x3 view you can use two filters: 

 Baseline filter 

 Muscle filter 
 
Both filter options can be found in the Action menu. Select the appropriate filter to enable it. 
The filter option will be marked with a check. To disable the filter simply select it again. 
 
Note:  When you enable a filter from the Action menu it will also affect the full disclosure and 

4x3 or 2x6 view. 
 
Note:  You can tell which filters are enabled in the portion of the full disclosure, 2x6, and 4x3 

views by looking at the frequency response displayed.  If the baseline filter is 
enabled, the lower frequency will be 0.5Hz.  If the muscle filter is enabled, the upper 
frequency will be either 25 or 35 Hz (depending on the settings). 

 
If accurate ST segment contours are required for ECGs, do not use the 0.5 Hz baseline 
wander filter. This filter suppresses baseline wander to the extent that it may alter the ST 
segment. Instead, configure your cardiograph to operate without the baseline wander filter. 
Regardless of the filter used, the rhythm characteristics of the ECG are accurately recorded 
and do not affect the interpretation algorithm.  
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3.7  Work with the Trends view 
Trends view 

 
 
The trends view displays various trend graphs: 

ST trends For each of the twelve leads, the Trends view displays the ST trends 
as measured from the ST reference point, together with the ST 
slopes. You can change the ST reference point. 

  Workload graph The Workload graph shows the workload against time. The workload 
is expressed in Watts for an ergometer test, and in METS for 
treadmill tests. 

  Heart rate graph The Heart rate graph shows the patient's heart rate against time. 
From the shortcut menu you can also select to display the VES trend 
in the Heart rate graph. 

  Blood pressure 
graph 

The blood pressure graph shows the patient's blood pressure 
against time. From the shortcut menu you can also select to display 
the RPP in the Blood pressure graph. 

  
  

3.7.1. Set a different ST reference point 
You can change the reference point for the ST calculation both during recording and viewing.  
 
The values for the ST reference point can be: 

 J+0 

 J+20 

 J+40 

 J+60 

 J+80 

 J+Dynamic (J+1/16*(R-R)) 
  
To set a different ST reference point: 

 In the View menu, point to ST Reference Point and select a value. 

 You can also change the QRS end (J) marker yourself in the Average complex view. 
See page 33. 
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3.7.2. Display ST slopes 

Welch Allyn CardioPerfect Exercise ECG not only measures ST levels, but can also calculate 
the value of ST slopes. The ST slope value gives additional qualitative information about your 
ST level measurements.  
 
The ST slope is calculated as follows: (ST at J+60 - ST at J+40) / 20 msec. 
 
To display slopes: 

 Click with your right mouse button on the view to display the shortcut menu. Click 
Slopes to display the slopes. Click once more to hide the slopes. 

 

3.8  Work with the ST table view 
ST table view 

  
 
Note: To make the display easier to read select colored bands from the right-click menu. 
 
The ST table view shows points in the recording together with the stage, workload or 
speed/elevation, blood pressure, heart rate, rate pressure product, the PQ and the QRS 
duration, and the ST values for various leads. 
 
To select the points in time for which this information is displayed: 

 In the Selection list, click on a selection. 
 

3.8.1. Rate pressure product 

The rate pressure product gives information about the strain on the myocardial muscle. It is 
calculated as follows: 
 
RPP = (Systolic blood pressure * heart rate) 
The RPP is listed in the Trends view in units of 100 bpm.mmHg. 
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3.8.2. Copy ST measurements into other applications: 

The ST table can be copied, fully or partly, into other MS windows applications. Select a 
single measurement row with a left mouse click or select multiple rows with <Ctrl> left mouse 
click and/or <Shift> left mouse click (for a group of contiguous rows). Use the copy option 
available from the shortcut menu to copy and paste the text into other MS windows 
applications.   
 

3.9  Work with the Heart rate view 

3.9.1. Heart rate view 

  
 
The Heart rate view displays information about how the patient's heart rate evolved during the 
test. The upper graph displays the patient's heart rate against time. The lower graph displays 
the workload against time. 
 
Phase changes are indicated with a vertical dotted line. 
 

3.9.2. Compare heart rate graphs 
If a patient has had several exercise ECGs, Welch Allyn CardioPerfect Exercise ECG can 
make a serial comparison of the patient's heart rate during these tests. In such a comparison, 
the curves are superimposed. 
 
To compare heart rates: 

1. In the Heart rates view, click your right mouse button on one of the graphs to display 
the shortcut menu. 

2. In the shortcut menu, click Comparison. The Comparison dialog box is displayed. 
This dialog box contains all other exercise ECGs that have been recorded for this 
patient. 

3. In the Comparison dialog box, select one ECG to which you want to compare the 
current ECG. 

4. Click OK. The heart rate graph of the selected exercise ECGs is superimposed on 
the current exercise ECG. 
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3.10  Work with the ST/HR view 

3.10.1. ST/HR view 

  
 
The ST/HR view plots the ST segment depression against the heart rate. You can display this 
graph for each lead. In the left hand pane, the ST/HR index is shown. More information can 
be found in Okin PM, Kligfield P (1989), Computer-based implementation of the ST-
segment/heart rate slope, American Journal of Cardiology. 
You can select to show the exercise phase, the recovery phase or both by checking the 
option from the checkbox above the graph. 
 
To display the ST/HR graph for a different lead: 

 Click on a lead in the left hand pane or select the lead from the drop down box. 
 
To invert the ST/HR curve: 

 Click on the graph with your right mouse button and select Invert from the shortcut 
menu. Click once more to flip the graph back to its original position. 
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4. Interpreting an exercise ECG 
Once you have viewed, measured and compared the information in the exercise ECG, you 
can add, edit and confirm the interpretation.  
 

4.1  Edit, save and confirm interpretation 
After test anyone with edit rights can edit an unconfirmed interpretation in the Interpretation 
editor. In this editor, you can enter your own texts. Alternatively, you can use the statement 
tree to select and enter common interpretation statements. Until confirmed, the test will be 
labeled as „Unconfirmed Interpretation‟. 
 
Once the interpretation has been confirmed by a physician, only a user with confirm 
interpretation rights can further edit the interpretation. For more information on user rights see 
the Administrator tool. 
 
To enter text in the Interpretation editor: 

1. In the Tools menu, click Interpretation. The Interpretation editor is displayed.  
 

 
 
Once the interpretation is confirmed the save button will be grayed out. 

2. In the right hand pane, at the pointer, start typing. 

  
To enter a statement from the statement tree: 

1. From the statement tree, click on one of the categories to display all possible 
statements for that category. 

2. From a category, click on the statement that you want to include in the interpretation. 
The statement is added.  

3. To delete a statement from the interpretation, select the statement text and press 
BACKSPACE to delete it. 

4. Click the Save (or Confirm, if available) button to save your comments and to return 
to the ECG. 

  
Tips for editing and confirming an interpretation: 

 You can automatically insert the current date and time by clicking the Date/time 
button.  

 You can clear the interpretation editor by clicking the Clear button. 
  



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  41 / 83 

4.2  View interpretation history 
When you change something in an interpretation, Welch Allyn CardioPerfect Exercise ECG 
does not change the original interpretation, but creates a new one. This way, an audit trail is 
kept of the interpretation history. A copy of all interpretations is kept in the interpretation 
history. 
 
 
To view the interpretation history: 

1. In the Tools menu, click History. The Interpretation history window is displayed. The 
left hand pane displays the interpretations sorted by date. The right hand pane shows 
the content of each interpretation, plus the interpretation date, time and the person 
who modified the interpretation. 
 

 
 

2. Click on a date to view an interpretation. 

 
 

4.3  Clean up full disclosure 
An exercise ECG uses a lot of space on your computer. To reduce the used space, you can 
delete some or all leads from the full disclosure. 
 
Important: When you remove leads from the full disclosure, you cannot use the 2x6 or 

4x3 view or the 2x6 or 4x3 report formats any longer. 
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To delete some or all leads from the full disclosure: 

1. In the Tools menu, click Full disclosure clean up... 
 

 
 

2. In the Full disclosure cleanup window, select whether you want to delete all leads or 
specific leads. 

3. If you selected specific leads, click on the lead that you want to delete, and use the 
arrow button to move that lead to the right hand column. 

4. Click OK.  
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5. Printing an exercise ECG 
This section holds a brief outline on printing an exercise ECG for a more elaborate description 
on printing with the Welch Allyn CardioPerfect software please refer to the Workstation 
manual. 

5.1  Print an exercise ECG 
You can make a printout of each view in the exercise ECG.  
 
Making a printout 

  
 

Click on the Print button in the toolbar or select Print from the File menu. 
 

  
 

Select the report you want to print. 
 
There are two ways of manually printing an ECG: 
 

 Single view: Welch Allyn CardioPerfect prints the view currently showing in the review 
window.  

 Selected formats: Welch Allyn CardioPerfect prints a number of reports 
simultaneously. The views which are printed are selected in File – Settings. 
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5.1.1. Print formats 

The exercise ECG Module can print the following reports: 
 

 2x6 Sequential or Simultaneous 

 4x3 + 1R Sequential or Simultaneous 

 Averages 2 pages Cabrera 

 Averages 2 pages 

 Averages 

 Full disclosure 25 mm/s 

 Full disclosure 10 mm/s 

 Full disclosure 5 mm/s 

 Heart rate 

 Rhythm 

 ST table 

 ST trends 

 Summary 
 
Each report contains the view and a header that displays additional information.  
 
Please refer to the Workstation manual for further information on printing exercise ECGs. 
 

5.2  Automatically print an exercise ECG 
Welch Allyn CardioPerfect Exercise ECG can automatically print an exercise ECG directly 
after recording.  
 
To automatically print an ECG after recording, you need to: 

 Enable automatic printing by selecting Print after recording in the Exercise ECG 
settings. 

 Define a number of pre-selected formats that you want to have printed. Select the 
formats in the Exercise ECG settings menu from the Default report formats list.  
These will be the same formats that the Print Selected Formats button will print. 
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6. Maintaining the recorder 

6.1  About maintaining the recorder 
To keep your Welch Allyn CardioPerfect recorder in good working condition, please observe 
the following: 
 

 Remove the battery when you do not use the recorder for a long period of time. 

 Do not expose the recorder to temperatures lower than -15 ºC or higher than 45 ºC, 
at a maximum non-condensing humidity of 95%. 

 Clean the cables regularly. 

 Replace the battery of the recorder when the power indicator light is red. 
 

6.2  Cleaning the Patient cables and PC interface cables 
When you use electrodes that need electrode gel, make sure that the cables and the non-
disposable electrodes are cleaned regularly. Otherwise, the gel may build up on the wires. 
 
Clean the cables and the non-disposable electrodes with a soft cloth moistened with a 
recommended disinfectant or cleaning agent. 
 
Cleaning cables: patient cables, plugs and power cords should be kept clean using lukewarm 
soapy water or a neutral cleaner. 
  
Disinfecting the cables: use chemical disinfectants containing ethanol (70%-80%), propanol 
(70%-80%) or aldehydes (2%-4%). 
 

 

 Caution 
 

Do not: Clean the patient cable with pure alcohol. Pure alcohol 
can cause the plastic to become brittle and may cause 
the cable to fail prematurely. 

Do not: Autoclave the cable or use ultrasonic cleaners. 

Do not: Immerse the patient cable. 

Do not: Wet the connectors. 

 
 

6.3  Replace the battery of the recorder 
 

6.3.1. Welch Allyn CardioPerfect MD recorders 
The Welch Allyn CardioPerfect MD recorders get their power from a 9V alkaline battery or 
optionally from an AC-mains adapter. If a 9V battery is used, you need to replace it when the 
power indicator light becomes red instead of green. Do not use the recorder when the power 
indicator led is red. 
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To replace the battery of Welch Allyn CardioPerfect MD models: 
 

 
The battery compartment is located at the bottom of the unit. 

 

1. Place your fingers in the two recesses of the battery compartment. 

2. Remove the lid by squeezing it. 

3. Unfasten and remove the battery.  

4. Insert a new 9V alkaline battery. 

5. Click the lid back into place. 

 
After you have replaced the batteries, let the Welch Allyn CardioPerfect software run in 
Monitor mode for a few seconds. This verifies that the recorder functions properly and the 
optical cable is undamaged. 
 

 

 Warning 
 

It is strictly forbidden to use a non-medical approved 9V AC 
mains adapter, because of patient safety. 

 

 

 Caution 
 

Please observe the following: 
We advise you not to use rechargeable batteries, because their 
voltage can drop steeply without warning. This can stop the ECG 
monitoring during a test. 

 
  

6.3.2. Welch Allyn CardioPerfect Pro recorders 
The Welch Allyn CardioPerfect Pro recorders get their power either via a USB connection or 
via a rechargeable battery. If a USB-Prolink is used, the Welch Allyn CardioPerfect Pro 
recorder gets its power from the USB port of the computer, the battery pack supplied with the 
recorder is then a so-called dummy. 
 
If the recorder is connected to the computer by means of an RS232 Prolink, the power is 
supplied by a battery-pack in the bottom of the recorder, this battery pack needs to be 
recharged (charger is supplied with the system) when the indicator turns red. 
 
 

 

 Caution 
 

If the recorder is powered from the USB port, but also has a 
battery pack, this battery will be drained slowly as well and if the 
recorder detects an empty battery it will not function until the 
battery is recharged or removed. 

 
After you have replaced or charged (Pro) the batteries, let the Welch Allyn CardioPerfect 
software run in Monitor mode for a few seconds. This verifies that the recorder functions 
properly. 
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 To charge the battery of Welch Allyn CardioPerfect Pro models: 

  
 
The battery compartment is located at the bottom of the unit. 

1. Pull the battery compartment from the recorder by holding the Welch Allyn 
CardioPerfect Pro recorder with one hand and pressing on both sides off the battery 
compartment with your other hand. 

2. Connect the power adapter to an electrical outlet, insert the charger cable into the top 
of the battery pack. Recharge your battery. 

3. Click the battery compartment back into place when the battery has been recharged. 
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7. Customizing the Exercise ECG module 
You can customize Welch Allyn CardioPerfect to your own preferences. To open the settings 
click Settings in the File menu. 
 
The features that you can customize are located in the Exercise ECG settings. In the 
navigation bar click Exercise ECG: 
 
 

7.1  Exercise ECG settings- General tab 
Use the General tab to customize general functions of Welch Allyn CardioPerfect Exercise 
ECG. 
 
The General tab contains the following options: 

Lead Preference In this section you can specify your own favorite lead sequence. Use 
the arrows to move a lead up or down. The favorite lead sequence is 
available in the Averages view and the Real-time monitor. When 
displaying views with fewer than 12 leads, the leads that are shown 
are selected from the top down from this list, thus a 3 lead view 
shows the top 3 leads. 

  ST options:  

Reference Point With this setting, you can determine the default point that is taken 
for ST measurement. Possible choices are: J+0, J+20, J+40,J+60, 
J+80, J+Dynamic. The latter option calculates the ST measurement 
point based on the actual heart rate, as  
J + RR/16. 

  Highest ST 
calculation 

With this setting, you can specify how the highest ST should be 
calculated. You can choose between:  
- “Absolute ST deviation”: for the lead specified, the ST event is 

reported for which the absolute ST value in that lead is maximal. 
- “Summation”: the ST event is reported for which the summation 

of the absolute ST values across all leads is maximal.  
- “ST depression only”:  for the lead specified, the ST event is 

reported for which the ST value is maximally negative.. 

  Highest ST lead If you have set the Highest ST calculation option to Absolute ST 
deviation or ST depression only, use the Highest ST lead to specify 
which lead should be used for this setting. Possible choices are: I, 
II, III, aVF, aVL, aVR, V1, V2, V3, V4, V5, V6 and –aVR or Lead 
with maximum ST.  
 
Note: when “lead with maximum ST” is used in combination with 
“ST depression only”, the leads aVR and V1 will not be used in the 
determination of the lead with the highest ST. 

  Rhythm lead Here you can select which lead should be shown as rhythm lead in 
the 4x3 view. 

  Speed unit With this option, you can select the unit in which the treadmill speed 
is expressed. You can select either km/h or mph. 
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Lead order With this option, you can select the order in which the leads are 
displayed. Two ECG lead sequences are provided: the standard 
lead sequence or the Cabrera format. 

  Amplitude unit With this option, you can select the unit in which the measured 
amplitudes are expressed. You can select either millimeter or 
microvolt. The millimeter setting is dependent on the sensitivity that 
you use. The microvolt setting is sensitivity-independent. 

  Muscle filter 
frequency 

This setting will affect the high cutoff frequency that is used by the 
muscle filter. 

  Minimum last stage 
duration 

Enter the minimum duration of the last stage in seconds. 

Show Pacer By checking or unchecking the Show Pacer box, you can control 
whether a test will start with artificial pacemaker signal indicators on  
or off. During the test and during post-test review you will also be 
able to turn the pacemaker marks on or off.  For example, see 
Pacemaker pulse detection on page 25. 
 

  

7.2  Exercise ECG settings- Viewing tab 
Use the Viewing tab in the ECG settings window to configure how ECGs are displayed on 
your Workstation.  
 
The Viewing tab contains the following options: 

  Colors Here, you can specify individual colors for the background, axis and 
grid lines, trends, superimpose and ST markers. 

  Color schemes This list lets you choose from a number of predefined color schemes. 

  Selections Here, you can define selections. A selection is a group of events that 
appear together on the Averages, ST measurements and ECG 
strips, both in print and on the monitor. By defining different 
selections, you can customize what should be printed and displayed. 

  Averages With this option, you can define a selection of events for which you 
want to print or display the corresponding averages. 

  ST table With this option, you can define a selection of events for which you 
want to print or display the corresponding ST values. 

  2x6 With this option, you can define a selection of events for which you 
want to print or display the corresponding 2x6 ECG strips. 

  Visible arrhythmia With this option you can select which arrhythmia will be printed or 
displayed. 

  

7.2.1. Selections for viewing and printing 

A selection is a collection of events which you choose to allow quick navigation through the 
Averages, ST measurements and ECG strips, while reviewing on the monitor. The selection 
definition can also affect portions of the summary report.   
 
Which ever selection is chosen for Averages, ST measurements, and ECG strips will drive the 
list which is displayed when the mouse moves over the binoculars as described in section 
3.2.3 on page 29.  
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You can create a selection in three ways: 

 A selection of events: all events of a certain kind are included, such as all 
arrhythmias, all start points of a new phase, or all user events. 

 A selection of common or similar points in a test: for example, all blood pressure 
measurements that were made during the Exercise phase. 

 A selection of points at specific times during the test 
  
 
To create a selection of events for printing or viewing: 

1. In the Exercise ECG settings, click on the Viewing tab. 

2. In the Selection area, click the Configure... button. The Configure selections dialog 
box is displayed. 

3. In the Configure selections dialog box, click the Add button. The Edit selection dialog 
is displayed. 

4. Enter a name for the selection. 
 

 
 

5.  In the Global events area, select the events that you want to include in your 
selection. 

6. In the Events per phase type area, select the events from the phase that you want to 
include in your selection. You can use both events from the Global events area and 
the Events per phase type area in one selection. 

7. Click OK. 

 
To create a selection that shows information at fixed points of time in the recording: 

1. In the Events per phase type area, select intervals for the phases that you want to 
include in your selection. For example, if you want to show information from the 
Exercise and Recovery phase, click the Interval check box in the Exercise and 
Recovery column. 

2. In the Interval (seconds) area, enter the values for the intervals that you selected in 
the previous step. (the time between the first display of the event and the next display 
of the event in seconds).  

3. In the Interval (start) area, enter the start time of the interval display. 
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Examples 
 

If you select... In phase... You see... 

Blood pressure Exercise All blood pressure measurements that were entered during 
the Exercise phase, but no blood pressure measurements 
that were recorded during the Pretest, Recovery or Posttest 
phases. 
 

Interval 
Interval = 120 
Start at = 180 

Recovery An event at 3 minutes (=180 seconds), 5 minutes (Start time 
with interval time added = 180 seconds + 120 seconds), 7 
minutes (previous + 120 seconds), etc. after the start of the 
Recovery phase. 

 
  
Display of selections 
For each event identified by a selection, Welch Allyn CardioPerfect Exercise ECG creates the 
following displays: 

 In the 2x6 or 4x3 view: there will be a waveform display representing the time when 
the event occurred 

 In the ST table view: the will be a line of ST measurement data associated with the 
event 

 In the Averages view: there will be a set of averages associated with the event 

7.3  Exercise ECG settings- Printing tab 
Use the Printing tab to configure the automatic printing settings.  
 
The Printing tab contains the following options: 

  Printing during test 
These settings can still be changed when you create a new exercise ECG. New print 
protocols can be added using the Protocol editor see page 60. 

  Protocol Here you can select if a report should be printed at the end of each 
stage, manually triggered or according to a user defined protocol. 

  Print format From this list, you can select the printing protocol that is used for 
printing during recording. 

  Grid From this list, you can select the grid style used for the printouts 
during the test. The grid style used for printouts after recording is 
set separately (see the Default report formats section below) 

  

Interval checkbox 
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Default report formats (printing after recording) 

  Selected From this list of formats, you can select the formats that are printed 
when automatic printing is enabled. These formats are also printed 
when you click Print selected formats in the ECG window. 

  Full disclosure lead From this list, you can select the default lead that appears in the 
Full disclosure view and print. 

  Grid From this list, you can select the grid style used for the printouts 
after recording is completed.  The grid styles for printing during test 
and printing after recording are independent and must be selected 
separately. 

  Print after recording If this option (checkbox) is selected, the ECG is automatically printed 
when the recording has finished. Welch Allyn CardioPerfect Exercise 
ECG prints the formats that you selected in the Default report 
formats area.  

   

7.3.1. Set selected formats 

This selection defines which report formats will be printed after recording or when you click 
the Print selected formats button. To print a view of an ECG, you need to select its 
corresponding format in the ECG settings. 
 
To set the printing options: 

1. In the File menu, click Settings. The Settings dialog box is displayed. 

2. Click Exercise ECG and click on the Printing tab. 

3. In the Printing tab,  

a. To enable automatic printing: click Print after recording. 
b. To select formats in which the ECG should be printed: select one or more 

default report templates 

4. Click OK to save your changes. 

 

7.4  Exercise ECG-settings- Monitor tab 
Use the Monitor tab to configure recording settings. The Monitor tab contains the following 
options: 
 
Predefined comments: 
Here, you can define pre-entered comments that can be used during the recording of the 
ECG. They become available in the Comment window. 
 
Use event dispatcher for external applications 
Use this option to start the event dispatcher during monitoring. The event dispatcher can be 
used to interface to an external application, such as a gas exchange system. This can only be 
done if that application uses a compatible interface. 
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7.5  Exercise ECG-settings -Devices tab 
Use the Devices tab to select and configure the exercise devices.   
 
Important: In order to make changes in this section, you must have Windows 

Administration privileges.  These privileges are set outside of CardioPerfect 
application, and are specific to each computer. 

 
If a section is grayed out, you do not have the necessary privileges, and should consult your 
IT administrator. 
 
The Devices tab contains the following options: 

  Exercise device 

  Type The type of exercise device that is used during the exercise ECG. 

  Device Select your exercise device from the pull-down list, if your exercise 
device is not in the list or if you do not want your device to be 
controlled by the CardioPerfect workstation, then select “manual” 

  Connected to From this list, you can select the COM-port to which the exercise 
device is connected. This is only possible when the selected device 
has a serial (or RS232) interface. 

  Default protocol The default workload protocol that is used for the exercise ECG. 

  Instant manual load 
changes 

When this option is enabled the treadmill speed and elevation or the 
ergometer workload will be instantly adjustable in the Real-time 
monitor. 

  Blood pressure device 

  Device With this option you can specify which blood pressure device is 
used for measuring the patient's blood pressure during the exercise 
test. 

  Connected to From this list you can select the COM-port to which the blood 
pressure device is connected. 

  Default protocol With this option, you can specify which protocol is used by default 
for measuring the blood pressure during the test. Select Manually 
controlled if the blood pressure protocol will not be used or if the 
protocol is selected at the start of a test. 

    



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  54 / 83 

7.6  Exercise ECG settings- Recorder tab 
The Recorder tab is only accessible if you have Windows administrator rights. Use the 
Recorder tab to adjust settings for the Welch Allyn CardioPerfect recorder. 
 
The Recorder tab contains the following options: 

  Recorder model 

  Model The recorder model that is used. Use the MDX4 option for an 
MD recorder at 300, 600 Hz or 1200 Hz. Use the MDXN1 for 
a Pro recorder. 

  Sample Frequency The sampling frequency of the recorder (300, 600 or 1200 
Hz). 

  AC mains frequency The frequency that is filtered by the AC mains filter. You can 
choose between 50 and 60 Hz. 

  Recorder connection  

  Port type The communication port of the PC to which the recorder is 
connected. This can be a CPCOM PCI card, a CPCOM-ISA 
card, a CPCOM PCMCIA card or an USB port. 

  Analog output If you use a PCI card, or USB with an analog port, select the 
function of the analog output here. You can use the output to 
control an ergometer or to transmit the ECG signal. 

  Channel If you set the function of the analog output to transmitting the 
ECG signal, select the channel from which the ECG signal is 
taken here. 

  Recorder options  

  Display switch off message This option disables the display of the message “Switch 
recorder off” after a test has been completed. If a Welch Allyn 
CardioPerfect Pro recorder with USB connection is used this 
option should be off/unchecked. 

  Battery options  

  Enable low battery warning This option is only available for the PRO (MDXN1) recorder. 
With this option you can enable or disable the displaying of a 
low battery warning in the monitor. 

  Warn at In this field you can specify the remaining battery time at 
which the monitor should display the low battery warning. 
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7.7  Exercise ECG settings- Summary tab 
In the summary tab of the Exercise ECG settings the contents of the Summary report can be 
adjusted, see Viewing an exercise ECG page 28. The summary tab of the Exercise ECG 
settings shows which information is currently displayed in the Summary report view. 
 
To change the Summary report you can select a previously created template or add a new 
template. 
 

 
  

  Select the template to use for the XECG Summary page: 

   Select the preferred template with the Browse button. The 
information available in the template is shown below. 

  Add new template With this option you can customize the contents of the summary 
report. Clicking on the Add new template button will open the XECG 
Summary template wizard. 

  The selected template contains the following information 

   Displays the sections that are selected and will display in the 
summary report.   
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To customize a new summary report template: 

1. Click on the Add new template button in the Exercise ECG settings-Summary tab. 

2. Select which fields should be included in the Summary report.  
 
The options button will change with the option selected above the button, if no options 
are available for the selected item the button is disabled. 
 
For example: 
If Insert custom logo is selected the button changes to Insert custom logo, click on the 
button and you can browse for your own custom logo. 
If Maximum heart rate is selected, you can select the settings for the Maximum heart 
rate with the options button. 

 
 
 
 
 
 
 
 
Note: Which fields are displayed is optional; the location of the fields is fixed. 
 

3. Click Next. 

4. Enter a file name for the new Summary report template. 
Click Next.  
 
If the file name already exists a warning will appear. You can overwrite the old file or 
select cancel and add a new name. 
 
 

5. Select Yes to change your default summary report to the generated template. 
Select No to leave the settings as previous. The generated template will be available 
for subsequent use. 

6. Click the Finish button. 
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The window will close and the now available information in the summary report will be shown 
in the checkboxes.   
 
 
Editing existing templates 
It is possible to edit an existing template, a .htm file, by hand by using Notepad or a html 
editor. For more information see the section on customizing .txt files in the Workstation 
manual. 
 
Note: Do not overwrite the built-in default summary file: xecg_summary_std.htm as this file 
may be overwritten when updating the software. 
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8. Customize exercise protocols  

8.1  Protocols, phases and stages 
A protocol is a set of predefined rules and conventions of how a test is structured. With the 
Protocol editor, you can create protocols for 

 The structure of a treadmill test. 

 The structure of an ergometer test. 

 The points in time at which the blood pressure is automatically measured or the 
points in time when a Blood Pressure prompt will appear. 

 The points in time at which a copy of the test is automatically printed. 
The protocol editor is available from the Tools menu, when an Exercise ECG is displayed, or 
when Exercise ECG is opened from the File – Open menu. 
  
Phases 
Each protocol contains four phases:  

 Pre-test: this phase is normally used to allow the patient to get accustomed to the 
exercise device, and to record reference resting ECGs  

 Exercise: during this phase the exercise portion test takes place.   

 Recovery: during this phase the patient is allowed to recover from the test, monitoring 
of the patient continues  

 Post-test: the phase in which any post-test activity measurements take place.  
Monitoring of the patient continues 

 
A protocol does not necessarily need to use all four phases. Many protocols use only the 
Exercise and the Recovery phases.  Regardless of the phases selected, every patient 
heartbeat is recorded from the beginning of the test until the end 
 
Stages 
Each phase in a protocol consists of a number of stages. There is no limit as to the number of 
stages that make up a phase.  
  

8.2  Exercise Protocols overview 
All commands which allow editing or creating a protocol are available through right mouse 
button menus.  There are four kinds of protocols: 

 Ergometer protocols 

 Treadmill protocols 

 Blood pressure protocols 

 Printer protocols 
Normally you will create the exercise device (ergometer or treadmill) protocol first, and then 
ensure that the blood pressure and printer protocols are consistent with the exercise device 
protocol. 
 
The following sections give an overview of the exercise device protocols.  There are special 
variables that you can use to make the exercise device protocol quite sophisticated and 
flexible. These variables are also defined in the following sections: 
   

8.2.1. Ergometer protocols 
An ergometer protocol is a collection of stages that together define the ergometer test. For 
each stage in an ergometer protocol, you need to specify the name, duration, repetition, load 
and maximum load. The Protocol editor automatically generates a stage name; this name can 
be changed. 
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Expression: Variables 
You can use an expression to create a stage that is dependent on weight, height, age, etc. To 
create such an expression, you can use the following variables: 
 

Variable Explanation 

C Current value (Watts, km/h or %) 

KG Weight of the patient in kilograms 

A Age of the patient in years 

CM Height of the patient in centimeters 

HR Current heart rate 

 
Expression: Operators 
You can combine variables into an expression with the following operators: +  -  *  /  (  ) 
 
Examples 
Here are some examples of expressions: 

To... Use this expression... 

Increase ergometer load by 40 W C+40 

Increase ergometer load by half the weight C+(0.5*KG)  

 

8.2.2. Treadmill protocols 

A treadmill protocol is a collection of stages that together define the treadmill test. For each 
stage in a treadmill protocol, you need to specify the name, duration, repetition, speed and 
elevation. The Protocol editor automatically generates a stage number. 
 
Expression: Variables & Operators 
Please refer to the similar paragraphs in the previous description on Ergometer protocols. 
 
Note: The speed is always in km/h. To convert from mph to km/h, multiply the value in mph 

with the M factor. 
 

8.3  Blood pressure and Printer protocols 
Blood pressure protocols 
A blood pressure protocol can be used to automatically take blood pressure measurements 
during the exercise test. For each stage in a blood pressure protocol, you need to specify the 
name, duration and repetition. The Protocol editor automatically generates a stage number. 
 
Printer protocols 
A printer protocol can be used to automatically print copies during the test. For each stage in 
a printer protocol, you need to specify the name, duration and repetition. The Protocol editor 
automatically generates a stage number. 
 

8.3.1. Blood pressure of printer protocol modes 

Both Blood pressure protocol and Printer protocol can optionally be set to follow the exercise 
protocol in the protocol editor window.  
 
To set a Blood pressure or Printer protocol:  

 Select a protocol or enter a new protocol, see section 8.3 . 
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 Select a mode, see picture: 
 

 
 

1. Select Timed mode to create a protocol which will run independent of the ergometer 
or treadmill stages. An independent protocol consists of stages, each of which has its 
own duration.  Regardless of whether you hold or accelerate an exercise device 
stage, the independent BP or print protocol will continue to run using the stage 
intervals defined for that protocol.  

2. If you select Follow Exercise protocol mode the Blood pressure action (prompt or 
automatic BP start) or printout will occur at a fixed time after the start of each stage. 
All stage related fields and menus will then be disabled. Any information in the pane 
above the mode selector will be disregarded. 

3. You can select a different mode (independent or Follow Exercise protocol) for each 
phase 

 

8.4  Protocol editor window 
Use the Protocol editor window to create and edit protocols and their stages. 
  

 
 
Protocol list 
The left hand pane of the Protocol editor window contains a list with all existing protocols. 
These protocols are divided into treadmill protocols, ergometer protocols, blood pressure 
protocols and printer protocols. 
 
Protocol workspace 
The right hand pane of the Protocol editor window is where you add, edit and delete stages. 
The workspace is divided into four tabs that represent the four phases in a protocol: pre-test, 
exercise, recovery and post-test. For each phase, you can create a number of stages. 
 
Menu bar 
Here, you find functionality to import and export protocols, and to consult the help file. 
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8.5  Working with protocols 
 

8.5.1. Create a new protocol 

The procedure for creating a new protocol is the same for treadmill, ergometer, blood 
pressure and printer protocols. After you create a new protocol, continue with defining the 
stages for that protocol. 
 
To create a new protocol: 

1. Select the Protocol editor from the Tools menu. 

2. In the left pane of the protocol editor, first left click on the type of protocol that you 
want to create (treadmill, ergometer, blood pressure or printer). Then right click on the 
selected protocol type. 

3. In the shortcut menu, click New. A new protocol is added to the protocol list. 

4. Select the measurement units (mph or km/hr) for the new protocol if a treadmill 
protocol was selected. 

5. Enter a name for the new protocol. 

 

8.5.2. Import a protocol 

With the import function, you can import protocols that were created with previous versions of 
Welch Allyn CardioPerfect Exercise ECG. 
 
To import a protocol: 

1. In the Protocol menu, click Import. 

2. In the Open dialog box, select the protocol that you want to import and click Open. 

 

8.5.3. Delete a protocol 

When you no longer use a protocol, you can delete it. 
 
To delete a protocol: 

1. Select the protocol that you want to delete. 

2. Right click on the protocol. 

3. In the shortcut menu, click Delete. 
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8.6  Working with stages 

8.6.1. Create a new stage 

Once you have created a new protocol, you can define the different stages for that protocol. 
Each phase in the protocol can have a number of stages. When you design these stages, 
take into account that not every test may use all phases, and that the protocol needs to be 
specified accordingly. Most Treadmill and Ergometer protocols only have stages in the 
Exercise and Recovery phase. 
 
To create a new stage: 

1. Select the protocol and phase to which you want to add the stage. 

2. Right click in the right pane of the Protocol editor. 

3. In the shortcut menu, click New. The Edit stage dialog box is displayed. 

4. Enter a name for the stage. 

5. Enter the duration of the stage (in seconds). If you select Never expires, the stage will 
continue for an indefinite number of seconds. 

6. Enter the number of times the stage should be repeated. If you select Loop forever, 
the stage will be repeated for an indefinite number of times. 

 
Note: It is not possible to add a new stage after a forever looping stage.  
 

7. For the Treadmill and Ergometer stage you can now enter either a value or an 
expression for: 

Stage for: Adjustable items: 

Treadmill Speed Km/h or mph 

 Elevation % 

Ergometer Workload Watt 

 
 

8.6.2. Edit a stage 

When you want to change an existing stage, you can use the edit function to make those 
changes. 
 
To edit a stage: 

1. Right click on the stage and click Edit in the shortcut menu. The Edit stage dialog box 
is displayed.  

2. Edit the information. 

 

8.6.3. Delete a stage 

When you no longer use a stage, you can delete it. 
 
To delete a stage: 

 Right click on the stage and click Delete in the shortcut menu.  
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9. Troubleshooting 

9.1  Test recovery 
Recover a test after a computer crash 
When a recording is not finished properly, for instance due to a computer crash, you can still 
recover the full disclosure of that recording.  
 
To recover a test after a computer crash: 

1. Start Workstation. 

2. Start Welch Allyn CardioPerfect Exercise ECG (for instance by opening another 
exercise ECG). 

3. In the Tools menu, click Full disclosure recovery...  
 

 
 

4. In the Full disclosure recovery dialog box, click on the recording that you want to 
recover and click Recover full disclosure. If the recovery was successful, a 
message is displayed. 

5. In the Patients tab, select the patient for whom you want to recover the exercise 
ECG. 

6. The recovered exercise ECG is listed in the test list. 

 
To delete unfinished recordings: 

1. In the Full disclosure recovery dialog box, click on the unfinished recording that you 
want to delete. 

2. Click Delete. The unfinished recording is deleted.  

 
To recover a test after the database connection has been lost: 
If during the test the connection to the database is lost, for example because of a loose 
network cable, the test will be saved in a file called “Emergency saved exercise ECG 
#x.MDW”  (x stands for a number, which is automatically generated) in the My Documents 
folder. 
After the database connection has been restored, this file can be imported into the database 
by using the import function in the Workstation (File – Import, browse to the My Documents 
folder and select the correct file).  

9.2  Troubleshooting 
The program does not respond when the recorder is switched on 

 Check the battery and replace or charge (Pro recorder) it when necessary. Make sure 
that the optical fiber is properly connected.  

 When you work with a RS232-Unilink, check whether you have configured the 
software to use the correct COM port.  

 When you use an ISA-CPCOM card, make sure that the address on the card 
matches the setting for the address in the „Recorder‟ tab. Also make sure that the 
IRQ you are using is not used by another device. 
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When you start a recording you do not see the ECG traces on the screen and you 
receive a number of errors 

 Make sure that the setting for the sampling frequency in the „Recorder‟ tab of the 
ECG settings matches the sampling frequency of your recorder. The sampling 
frequency can be either 300, 600 or 1200 Hz.  

 Make sure that the correct Recorder model is selected (File> Settings> Exercise 
ECG> Recorder tab). Use the MDX4 option for an MD recorder at 300, 600 Hz or 
1200 Hz. Use the MDXN1 for a Pro recorder. 

 
Some buttons or menu entries are inactive 

 This is probably caused by the fact that your user role does not allow you to perform 
the actions of those buttons or menu entries.  For some advanced settings you have 
to be logged on as administrator. Please contact your system administrator for more 
information. 

 
The Service and Advanced Installation manual contains a section specific to Exercise ECG 
with additional troubleshooting information. 
  

9.3  Technical Support 
If you have a technical question that you cannot answer with the provided tools, please 
contact our Installation & Support department or contact your local distributor. 
 
When you contact the Installation & Support department via phone, e-mail or fax, please 
provide the following information: 

 Your name, company name, address, phone number, fax number and e-mail 
address. 

 Product serial number. 

 Exact product name and version number. 

 Type of operating system. 

 Type of installation (network or standalone). 

 A copy of the CCW Technical Support Form: 

 Complete description of the problem and the steps to reproduce it. If applicable we 
would also like to have the exact error message. 

 
To print the Technical support form: 

1. In the Help menu, click Information.  

2. Click on the Registration tab. 

3. Click on the Support... button. The Welch Allyn CardioPerfect support form is now 
printed and saved as file MDW.txt in the MDW installation directory. You can fax the 
printout or e-mail the file. 
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10. Before installing the Exercise ECG software 
In this chapter, you will find information about the structure of the Welch Allyn CardioPerfect 
Exercise ECG software. 
 

10.1  Structure 
The workstation consists of two elements:  

 Hardware: the recorder and the interface to the computer. 

 Software: the Exercise ECG module that runs in the Welch Allyn CardioPerfect 
Workstation. 

 
The recorder must be connected to the computer that runs the module. 
 
Software 
The Exercise ECG module is automatically installed with Welch Allyn CardioPerfect 
Workstation. For instructions on how to install and configure Welch Allyn CardioPerfect 
Workstation, please refer to the Installation and Configuration manual. 
 
Hardware 
Two different types of recorders are available, the MD recorder and the Pro recorder. The 
recorder with a patient cable, with which you record the ECG, is connected to the PC through 
an interface; different types of interfaces are available: 

 The MD recorder communicates with the computer through an optical fiber which is 
connected to a so-called Unilink (USB or RS232 only with Stress light) or to a so-
called CPCOM card 

 The Pro recorder uses a Prolink USB or Prolink RS232 to communicate with the 
computer 

 
Install Unilink or CPCOM? 
A Unilink is a small optical to electrical interface. There are two versions of the Unilink: the 
serial or RS232 Unilink, only used with Rest ECGs or Stress light versions, and the USB 
Unilink.  
The Welch Allyn CardioPerfect ECG recording system can optionally be supplied with a 
CPCOM card. This is an expansion card which either plugs into a PCI expansion slot or into a 
PCMCIA socket. This card essentially takes over the function of the Unilink but, compared to 
the RS232 version, it has an additional capability to buffer the incoming measurements.  
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11. Installing the Exercise ECG Module 
Before you can start recording ECGs, you need to  

 Install the hardware 

 Install the correct drivers (when you use a CPCOM card or USB Unilink) 

 Configure the software 
 
The installation procedures of the CPCOM cards depend on the operating system of your 
computer. Therefore, all sets of instructions include explanations for each operating system.  

11.1  Connecting the RS232 interface (Rest or Stress light 
versions) 

The RS232 interface is a Unilink for MD recorder or Prolink for Pro recorders. The RS232 
Interface can be used with all versions of MS Windows. To use an RS232 Interface, you need 
a free serial port on your computer. You cannot use the RS232 Unilink with the normal Welch 
Allyn CardioPerfect Exercise ECG module. 
 
To set up your computer for use of the RS232 Interface: 

1. Connect the RS232 Interface to one of the serial ports of the computer.  

2. If a Pro-recorder is used, connect the other end of the interface directly to the 
recorder 

 
If a Portable or MD recorder is used, insert one end of the optical fiber into the optical output 
receptacle at the back of the recorder and insert the other end into the respectable on the 
interface. 
After you have connected the Interface you need to configure Welch Allyn CardioPerfect 
Workstation so that it uses the correct port. 
 
To configure Welch Allyn CardioPerfect Workstation: 

1. Start Welch Allyn CardioPerfect Workstation and log in as Administrator. 

2. In the File menu, click Settings, click Exercise ECG, and click on the Recorder tab. 

3. From the Port list, select the COM port to which the Interface is connected. Most 
often this is either COM1 or COM2. 

11.2  Connecting the USB Interface 
The USB Interface, Unilink for MD and Prolink for Pro, cannot be used with MS Windows 95 
or MS Windows NT4. To use a USB Interface, you need a free USB port on your computer.  
On the Installer menu of the Welch Allyn CardioPerfect Workstation you will find an item 
called “Install Unilink USB / CardioPerfect Pro Drivers”  
 

→ Please run this install prior to inserting the USB-Interface into a USB socket of your 

computer. 
 
The installation wizard will prompt you to select whether the USB-Unilink drivers or the 
Prolink-USB drivers should be installed. 
 
To set up your computer for use of the USB Unilink Interface: 

1. Connect the USB Interface to the USB port of the computer.  

2. If a Pro-recorder is used, connect the other end of the interface directly to the 
recorder 
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3. If a Portable or MD recorder is used, insert one end of the optical fiber into the optical 
output receptacle at the back of the recorder and insert the other end into the 
receptacle on the Unilink. 

 
When you connect the USB Interface to a USB port for the first time, the system will tell you 
that it has found new hardware and it is trying to locate the drivers for it, provided that you 
have executed the installation of the drivers from the installer menu, the drivers will be 
detected automatically and correctly setup (this may take a few minutes). 
If, at a certain moment the USB interface is inserted into another USB port, the driver setup 
will be repeated automatically. 
 
After you have connected the Interface and installed the driver you need to configure Welch 
Allyn CardioPerfect Workstation so that it uses the USB port. 
 
To configure Welch Allyn CardioPerfect Workstation: 

1. Start Welch Allyn CardioPerfect Workstation and log in as Administrator. 

2. In the File menu, click Settings, click Exercise ECG, and click on the Recorder tab. 

3. From the Port list, select Unilink USB (This is the default setting after a new 
installation). 

  

11.3  R-wave triggering Interface capabilities 
 
The Welch Allyn PRO Link interface cable provides both a TTL and an Analog representation 
of the QRS complex.  
 

 The analog output, rendered on port 1, is an approximate representation of the signal 
on lead II.  The analog signal output is dependent on the input stimulus and uses a 1 
V/mV conversion. Stimulus ranges from 0 volts to 5 volts peak to peak.   

 The TTL output, rendered on port 2, is a digital signal 5V amplitude with a duration of 
120ms. It is triggered by the rising edge of the R-wave.  This can by used to interface 
to devices for R-wave triggering. The delay between R wave peak and TTL output 
pulse is typically between 30 and 50 ms. 

 
It is the responsibility of the user to ensure the compatibility of the output with their device and 
its intended use.   
 

WARNING 

 
This output is not suitable for cardioversion synchronization. 
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Note: Cables which connect to the Pro Link must be terminated in a mini-phone, 3.5 mm, 
stereo plug.  The interfacing cables must follow the connection convention summarized by the 
following pin assignment diagram:  
 
 
 
 
 
 
 
 
 
 
 
 

Caution 

 
The TTL and Analog connections are not intended to be used with 
audio/IT equipment. 
 

 

11.4  Install the PCI CPCOM card (MD recorder only) 
When you want to use a PCI CPCOM card you need to have a free PCI slot on your 
computer. The installation of the PCI CPCOM card is relatively easy and can be done by 
following the instructions below: 

1. Open the computer. 

2. Insert the PCI CPCOM Card in an empty PCI slot and close the computer. 

3. Start the computer. The system will ask you for a driver when logging on to the 
computer for the first time after you installed the card. 

 

For 
Windows: 

Install the driver by running the setup program that is located on 
the Workstation CD, in the directory: 

2000 / XP R:\Drivers\CPCOM-PCI\Win2000\ 

For "R" substitute the drive letter of your CD_ROM drive. 

4. Restart the computer. 

 

Reference (-) Signal (+) 

Connector pin assignment 

TTL Analog 

 

 

No Connection 
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Configuring the Software 
After you have installed the PCI CPCOM card you need to configure the Workstation software 
in order to allow communication between the program and the PCI-CPCOM card.  
 
To configure Welch Allyn CardioPerfect Workstation: 

1. Start Welch Allyn CardioPerfect Workstation and log in as Administrator 

2. In the File menu, click Settings, click Exercise ECG and click on the Recorder tab. 

3. Set the Port setting to CPCOM-PCI.  

4. Click OK to save your settings. 

 

11.5  Install the PCMCIA CPCOM Card (MD recorder only) 
The use of a PCMCIA CPCOM card requires a free type II PCMCIA slot and is not supported 
on Windows NT 4. 
The installation of the PCI CPCOM card is relatively easy and can be done by following the 
instructions below: 

1. Insert the Card into the PC. 

2. The operating system will ask you for a driver upon insertion of the card into one of 
the PCMCIA slots. 
 

For 
Windows: 

Select the driver file that is located on the Welch Allyn 
CardioPerfect Workstation CD, in the directory: 

2000 / XP R:\Drivers\ CPCOM-PCMCIA\Win2000\\ 

For "R" substitute the drive letter of your CD_ROM drive. 
 
Configuring the Software 
After installing the card you need to configure the Workstation software in order to allow 
communication between the program and the card.  
 
To configure Welch Allyn CardioPerfect Workstation: 

1. Start Welch Allyn CardioPerfect Workstation and log in as Administrator 

2. In the File menu, click Settings, click Exercise ECG and click on the Recorder tab. 

3. Set the Port setting to CPCOM-PCMCIA.  

4. Click on OK to save your settings. 
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12. Safety and precautions 
 

12.1  Conventions 
 

Warning Warning statements describe conditions or actions that can result 
in personal injury or loss of life. 
 

Caution Caution statements describe conditions or actions that can result 
in damage to the equipment or software. 
 

Note Notes contain additional information on cardiograph usage. 

 
 

 

 
 

 
Attention (Caution, Warning, Danger, Important, Note, Refer to 
Accompanying Documentation) 
 

 

 
Ingress Protection (ordinary) 
 

 

 
Serial Number 
 

 

 
Reference Number 
 

 

 
 

 
Type BF Equipment, defibrillation protected 
 

 

 
 

Manufacture Date 

 

 
 

CE Mark (according to MDD93/42/EEC) 

 

 
 

Temperature Range 

 

 
Direct Current 
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Electromagnetic Compatibility 
When using the CardioPerfect Pro cardiograph, electromagnetic compatibility with 
surrounding devices should be considered and evaluated. The CardioPerfect Pro cardiograph 
complies with IEC 60601-1-2 limits for EMC. 
 

12.2  General Safety and Precautions tips 
 

 

 Caution 
 

Radio Frequency (RF) interference between the cardiograph and 
any existing RF transmitting or receiving equipment at the 
installation site, including electrosurgical equipment, in close 
proximity to the cardiograph should be evaluated before the 
equipment is operated as they may seriously degrade 
performance. 
 
The CardioPerfect Cardiograph is susceptible to interference from 
RF energy sources (lowered RF immunity) which exceed the IEC 
60601-1-2 limits, such as power line bursts, other medical devices, 
cellular products, information technology equipment and 
radio/television transmission. 
 
To reduce EMC interference the cardiograph shall be separated 
from the emitting source as much as possible. If assistance is 
needed, call your local Welch Allyn service representative. 
 
Artifact on the ECG caused by electromagnetic interference 
should be evaluated by a physician or physician authorized 
personnel to determine if it will negatively impact patient diagnosis 
or treatment. 
 
Like all electronic devices, this cardiograph is susceptible to 
electrostatic discharge (ESD). Electrostatic discharge typically 
occurs when electrostatic energy is transferred to the patient, the 
electrodes, or the cardiograph. ESD may result in ECG artifact that 
may appear as narrow spikes on the cardiograph display or on the 
printed report. When ESD occurs, the cardiograph‟s ECG 
interpretation may be inconsistent with the physician‟s 
interpretation.  
Welch Allyn assumes no liability for failures resulting from RF 
interference between Welch Allyn medical electronics and any 
radio frequency generating equipment when these levels exceed 
those established by applicable standards. 

 
 
Patient and Operational Safety 
The cardiograph isolates all connections to the patient from electrical ground and all other 
conductive circuits in the cardiograph. This reduces the possibility of hazardous currents 
passing from the cardiograph through the patient‟s heart to ground. To ensure the patient‟s 
safety and your own please observe the following: 
 
Any system components (e.g. treadmill, personal computer, ergo meter) that require to be 
connected to an outlet socket shall use only grounded power cords (three-wire power cords 
with grounded plugs). Also make sure the outlet accepts the plug and is grounded. Never 
adapt a grounded plug to fit an ungrounded outlet by removing the ground prong or ground 
clip.  
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Multiple portable outlet sockets shall not be placed on the floor. Multiple portable outlet 
sockets or extension cord shall not be connected to the system. Do not connect items which 
are not part of the system The use of multiple (non-) medical electrical equipment connected 
to the same patient may pose a safety hazard due to the summation of leakage currents from 
each instrument. Any combination of (non-) medical electrical equipment should be evaluated 
by local safety personnel before put into service. Multiple portable outlet sockets use without 
an isolation transformer is disapproved unless casual access for additional equipment is 
impeded or prevented. 
 
Patient cable and Interface cable 

 

 Caution 
 

The patient cable supplied with the CardioPerfect cardiograph is 
an integral part of the cardiograph‟s safety features. Using any 
other patient cable may compromise defibrillation protection as 
well as cardiograph performance. The patient cable should be 
routed away from power cords and any other electrical equipment. 
Failure to do so can result in AC power line frequency interference 
on the ECG trace. 

   

 

 Warning 
 

Do not touch the patient, patient cable, PC interface cable 
(Prolink) or cardiograph during defibrillation. Death or injury may 
occur from the electrical shock delivered by the defibrillator. It is 
recommended to check the patient cable and PC interface cable 
(Prolink) for damage prior to the use of the system. If damage 
exists do not use the cable, contact your local Welch Allyn Sales 
Office or your authorized Welch Allyn dealer or distributor to have 
the cable replaced. 
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13. Guidance and Manufacturer’s Declarations 
 

 

 Caution 
 

The Welch Allyn CardioPerfect Pro Cardiograph needs special 
precautions regarding EMC and needs to be installed and put into 
service according to the following EMC information provided. 
 
Portable and mobile RF communications equipment can affect the 
Welch Allyn CardioPerfect Pro Cardiograph. 

 
 
 

Electromagnetic Emissions 

The Welch Allyn CardioPerfect Pro Cardiograph is intended for use in the electromagnetic environment specified 
below. The customer or the user of the Welch Allyn CardioPerfect Pro Cardiograph should assure that it is used in 

such an environment. 

Emissions test Compliance Electromagnetic environment – guidance 

RF emissions 
 
CISPR 11 

Group 1 

 
The Welch Allyn CardioPerfect Pro Cardiograph uses RF energy 
only for its internal function. Therefore, its RF emissions are very 
low and are not likely to cause any interference in nearby 
electronic equipment. 

RF emissions 
 
CISPR 11 

Class A 

 
The Welch Allyn CardioPerfect Pro Cardiograph is suitable for 
use in all establishments other than domestic, and may be used 
in domestic establishments and those directly connected to the 
public low-voltage power supply network that supplies buildings 
used for domestic purposes, provided the following warning is 
heeded: 
WARNING: This equipment/system is intended for use by 
healthcare professionals only.  This equipment/system may 
cause radio interference or may disrupt the operation of nearby 
equipment.  It may be necessary to take mitigation measures, 
such as re-orienting or relocating the Welch Allyn CardioPerfect 
Pro Cardiograph ro shielding the location. 

Harmonic emissions 
 
IEC 61000-3-2 

 

Class A 
 

Voltage fluctuations/ 
flicker emissions 
 
IEC 61000-3-3 

Complies 
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Electromagnetic Immunity 

The Welch Allyn CardioPerfect Pro Cardiograph is intended for use in the electromagnetic environment specified 
below. The customer or the user of the Welch Allyn CardioPerfect Pro Cardiograph should assure that it is used in 

such an environment. 

Immunity test IEC 60601 
test level 

Compliance level Electromagnetic environment 
– guidance 

Electrostatic discharge 
(ESD) 
 
IEC 61000-4-2 

±6 kV contact 
 
 
±8 kV air 

±6 kV contact 
 
 
±8 kV air 

Floors should be wood, concrete 
or ceramic tile. If floors are 
covered with synthetic material, 
the relative humidity should be at 
least 30 %. 

Electrical fast 
transient/burst 
 
IEC 61000-4-4 

±2 kV for power supply 
lines  
 
±1 kV for input/output lines 

±2 kV for power 
supply lines  
 
±1 kV for input/output 
lines  

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Surge  
 
IEC 61000-4-5 

±1 kV differential mode 
 
±2 kV common mode 

±1 kV differential 
mode 
 
±2 kV common mode  

Mains power quality should be 
that of a typical commercial or 
hospital environment. 

Voltage dips, short 
interruptions and 
voltage variations on 
power supply input lines 
  
IEC 61000-4-11 

<5 % UT 
(>95 % dip in UT) 
for 0,5 cycle 
 
40 % UT 
(60 % dip in UT) 
for 5 cycles 
 
70 % UT 
(30 % dip in UT) 
for 25 cycles 
 
<5 % UT 
(>95 % dip in UT) 
for 5 sec 

<5 % UT 
(>95 % dip in UT) 
for 0,5 cycle 
 
40 % UT 
(60 % dip in UT) 
for 5 cycles 
 
70 % UT 
(30 % dip in UT) 
for 25 cycles 
 
<5 % UT 
(>95 % dip in UT) 
for 5 sec  

Mains power quality should be 
that of a typical commercial or 
hospital environment. If the user 
of the Welch Allyn CardioPerfect 
Pro Cardiograph requires 
continued operation during 
power mains interruptions, it is 
recommended that the Welch 
Allyn CardioPerfect Pro 
Cardiograph be powered from an 
uninterruptible power supply or a 
battery. 

Power frequency (50/60 
Hz) magnetic field 
IEC 61000-4-8 

3 A/m 3 A/m Power frequency magnetic fields 
should be at levels characteristic 
of a typical location in a typical 
commercial or hospital 
environment. 

NOTE UT is the AC mains voltage prior to application of the test level. 
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Electromagnetic Immunity 

The Welch Allyn CardioPerfect Pro Cardiograph is intended for use in the electromagnetic environment specified 
below. The customer or the user of the Welch Allyn CardioPerfect Pro Cardiograph should assure that it is used in 

such an environment. 

Immunity test IEC 60601 
test level 

Compliance level Electromagnetic environment – 
guidance 

Conducted RF 
IEC 61000-4-6 

3 Vrms 
150 kHz to 80 MHz 

3 Vrms Portable and mobile RF communications 
equipment should be used no closer to any 
part of the Welch Allyn CardioPerfect Pro 
Cardiograph, including cables, than the 
recommended separation distance 
calculated from the equation applicable to 
the frequency of the transmitter. 
 

Recommended separation distance 

 

    

Radiated RF 
IEC 61000-4-3 
 

3 V/m 
80 MHz to 1 GHz 

3 V/m 

    80 to 800 MHz 
 

    800 MHz to 2,5 GHz 
 
where P is the maximum output power 
rating of the transmitter in watts (W) and d is 
the recommended separation distance in 
meters (m). 
Field strengths from fixed RF transmitters, 
as determined by an electromagnetic site 
survey

a
, should be less than the compliance 

level in each frequency range.
b
 

Interference may occur in the vicinity of 
equipment marked with the following 

symbol:  

NOTE 1    At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 
and reflection from structures, objects and people. 

a    Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land 
mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically 
with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site 
survey should be considered. If the measured field strength in the location in which the Welch Allyn 
CardioPerfect Pro Cardiograph is used exceeds the applicable RF compliance level above, the Welch Allyn 
CardioPerfect Pro Cardiograph should be observed to verify normal operation. If abnormal performance is 
observed, additional measures may be necessary, such as reorienting or relocating the Welch Allyn 
CardioPerfect Pro Cardiograph. 

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  76 / 83 

 

Recommended separation distances between portable and mobile RF 
communications equipment and the Welch Allyn CardioPerfect Pro 

Cardiograph 

The Welch Allyn CardioPerfect Pro Cardiograph is intended for use in an electromagnetic environment in which 
radiated RF disturbances are controlled. The customer or the user of the Welch Allyn CardioPerfect Pro Cardiograph 
can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF 

communications equipment (transmitters) and the Welch Allyn CardioPerfect Pro Cardiograph as recommended 
below, according to the maximum output power of the communications equipment. 

 
Rated maximum 
output power of 

transmitter 
W 

Separation distance according to frequency of transmitter 
m 

150 KHz to 80 MHz 

 

80 MHz to 800 MHz 

 

800 MHz to 2,5 GHz 

 

0,01 0.12 0.12 0.23 

0,1 0.37 0.37 0.74 

1 1.2 1.2 2.3 

10 3.7 3.7 7.4 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in 
meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the 
maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer. 

NOTE 1    At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 

NOTE 2    These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption 
and reflection from structures, objects and people. 
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14. Function keys 
The Welch Allyn CardioPerfect module is, just like all Windows applications, designed for 
working with the mouse. However, there might be situations in which working with the 
keyboard can be quicker. Therefore a number of functions within the Welch Allyn 
CardioPerfect module can also be selected directly using the keyboard. Here is a list of all 
available keyboard shortcuts in this module, for a more general function key description 
please refer to the Workstation manual: 

 
 

Real Time Monitor 

Key Function 

F2 Start/stop test 

F3 Baseline filter on/off 

F4 Muscle filter on/off 

F5 Blood pressure measurement 

F6 Insert comment 

F7 Insert Perception event 

F8 Print 

F9 Go to next stage 

F10 Hold stage 

F11 Go to next phase 

F12  Emergency stop 

[ALT]+[F9] Change load 

[CTRL]+[DOWN] Change load: Decrease load of ergometer or decrease elevation of 
treadmill. The control dialog will appear. 

[CTRL]+[UP] Change load: Increase load of ergometer or increase elevation of 
treadmill. The control dialog will appear. 

[CTRL]+[→] Change load: Increase speed of treadmill. The control dialog will 
appear. 

[CTRL]+[←] Change load: Decrease speed of treadmill. The control dialog will 
appear. 

[CTRL]+[1] Change monitor style to 12 leads 

[CTRL]+[6] Change monitor style to 6 leads 

[CTRL]+[3] Change monitor style to 3 leads 

[PgUp] Show previous lead group, in 3 or 6 lead monitor. 

[PgDn] Show next lead group, in 3 or 6 lead monitor. 

[ALT]+[0] Set the ST reference point to J+0 

[ALT]+[2] Set the ST reference point to J+20 

[ALT]+[4] Set the ST reference point to J+40 

[ALT]+[6] Set the ST reference point to J+60 

[ALT]+[8] Set the ST reference point to J+80 

[ALT]+[D] Set the ST reference point to Dynamic 

[INS] Inserts a user event in the recording  

[Esc] Exit the Real time monitor, cannot exit when recording is active.  
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Viewing 

Key Function 

[CTRL]+[DOWN] Zooms out. 

[CTRL]+[UP] Zooms in. 

[CTRL]+[Z] Reset zooming 

[CTRL]+[I] Opens the Interpretation window 

[CTRL]+[H] Opens the Interpretation History 

[CTRL]+[R] Activates the refresh functionality, which clears all user made 
measurements. 

[ALT]+[0] Set the ST reference point to J+0 

[ALT]+[2] Set the ST reference point to J+20 

[ALT]+[4] Set the ST reference point to J+40 

[ALT]+[6] Set the ST reference point to J+60 

[ALT]+[8] Set the ST reference point to J+80 

[ALT]+[D] Set the ST reference point to Dynamic 
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15. Additional information 

15.1  Duke Treadmill score 
The Duke Treadmill Score (DTS) was introduced by DB Mark cs

1
. According to the ACC/AHA 

Practice Guidelines, the Duke Treadmill Score adds significant prognostic information to the 
standard clinical data

3
. Besides improving diagnostic and prognostic accuracy, scores 

eliminate physician bias and lessen the variability of decision making
2
. 

 
The Duke Treadmill Score is calculated as follows: 
 
DTS = Exercise timemin – (5 * ST-segment deviationmm) – (4 * Exercise angina index) 
 
Angina index has a value of:  

0 for no exercise angina 
1 for non-limiting angina 
2 for exercise-limiting angina 

 
The Exercise time is originally measured in minutes of the Bruce protocol, which can be 
derived from attained metabolic equivalent. The resulting more universal version of this score 
translates the exercise duration (which assumes the Bruce protocol) from maximum attained 
METs, making it applicable for any exercise protocol or device type for which METs can be 
calculated or measured. 
 
Risk stratification based on the Duke score is estimated as: 
 

Score: Risk: 
> 5 Low risk 
-10 < Score < 5 Medium risk 
< -10 High risk 

 
The Duke Treadmill Score (DTS) is shown in the Summary tab if selected in the Summary 
template under Test results. See page 55 for more information. 
 
Note: The Duke Score is not applicable for pharmacological stress testing; it is only 

applicable if the selected exercise device is physically used.  
The Duke Score is not calculated if the Test type is not “Exercise.” 

 
Input variables:   

“Symptoms during test” -  used in determining Angina Index. 
“Reason for terminating test” -  used in determining Angina Index. 
“Stess Test type” -  if not a standard Exercise test, i.e. 

Pharmacological or other, then no DTS 
calculation. 
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in outpatients with suspected coronary artery disease. N Engl J Med 1991;325:849-
53. 

 

3. Gibbons RJ, et al. ACC/AHA 2002 Guideline Update for Exercise Testing. American 
College of Cardiology Foundation and the American Heart Association, 2002. 

 

15.2  Mets Value 
The METS value is interpolated. It gradually changes and attains the value predicted by the 
load-to-METS formula after the load change occurs on your stress device (2 minutes on a 
treadmill, 40 seconds on an ergometer). 



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  81 / 83 

Index 
2x6 ................................. 10, 28, 29, 35, 49 

Print ............................................... 26, 44 
4x3 ........................................28, 29, 35, 48 

Print ............................................... 26, 44 
Action menu ............. 18, 21, 23, 29, 32, 34 
Add comment .......................................... 21 
Arrhythmia ........................7, 11, 33, 34, 49 
Automatic 

Blood pressure ........................ 58, 59, 60 
Printing ....................... 44, 51, 52, 58, 59 

Average complex ........... 10, 13, 28, 33, 44 
View ........................... 31, 32, 36, 48, 51 

aVF ................................................... 31, 48 
aVL ......................................................... 48 
aVR ......................................................... 48 
Baseline filter .............................. 12, 23, 35 
Battery ..................... 45, 46, 47, 54, 63, 74 
Bigemini .................................................. 21 
Blood pressure......... 11, 13, 20, 31, 51, 58 

Device ................................................. 53 
Graph .................................................. 36 
Protocol ................ 15, 16, 20, 53, 59, 61 

Cables 
Cleaning .............................................. 45 

Cabrera ............................................. 44, 49 
Chart speed ................................ 10, 20, 28 
Clean cables ........................................... 45 
Comment 

Add ............................. 13, 17, 21, 22, 34 
Button .................................................. 11 
Window ............................................... 52 

Compare 
Averages ............................................. 32 
Heart rate graphs ................................ 38 

Computer crash ...................................... 63 
Configure ................................................ 49 

Automatic printing ......................... 26, 51 
Exercise device ................................... 53 
Recording settings .............................. 52 
Selections ............................................ 50 
Software ............................63, 66, 67, 69 

Connect 
Blood pressure Device ........................ 53 
Electrodes ........................................... 15 
Exercise Device .................................. 53 
Recorder ............................................. 54 
RS232 Unilink ..................................... 66 
USB Interface ...................................... 66 

Create 
New Exercise ECG ....................... 14, 15 
New patient ........ See  Workstation manual 
New stage ........................................... 62 
Protocol ............................................... 58 
Search pattern....................................... 8 
Selections ............................................ 49 

Customize 

General tab ......................................... 48 
Protocol .............................................. 58 
Selections ........................................... 49 
Summary report .................................. 55 
Welch Allyn CardioPerfect ................. 48 

Delete 
Protocol .............................................. 61 
Stage .................................................. 62 

Devices tab ............................................ 53 
Display 

Markers .............................................. 32 
RPP .................................................... 36 
Selections ........................................... 51 
ST slopes ........................................... 37 
ST/HR graph ...................................... 39 
Switch off message ............................ 54 
VES trend ........................................... 36 

Drivers .................................................... 66 
Duke Treadmill Score ............................ 79 
Edit 

Event .................................................. 21 
Interpretation ...................................... 40 
Markers .............................................. 33 
Physicians .......................................... 18 
Protocol .............................................. 58 
Selection ............................................. 50 
Stage .................................................. 62 
Template ............................................ 57 
Test .................................................... 29 

Emergency stop ..................................... 11 
Ergometer .............................................. 12 

Manual load change ........................... 23 
Protocol .............................................. 58 

Event ................................................ 29, 34 
Button ................................................. 11 
Capture ......................................... 14, 19 
Dispatcher .......................................... 52 
Edit ..................................................... 21 
Insert .................................................. 77 
Insert after recording .......................... 34 
List ...................................................... 12 
Selection ............................................. 49 

Exercise ECG 
Create new ......................................... 19 
Interpretation ...................................... 40 
New .............................................. 10, 15 
Record ................................................ 13 
Structure ............................................... 9 
View .................................................... 28 

Exercise ECG settings ........................... 50 
Favorites button ..................................... 31 
Full disclosure ........................................ 33 

Clean up ............................................. 42 
View .................................................... 32 

Heart rate ................................... 16, 26, 30 
Compare ............................................. 38 



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  82 / 83 

Graph .................................................. 36 
Trend ................................................... 31 
View .................................................... 38 

Highest ST ........................................ 13, 48 
History ..................................................... 41 

Tab ...................................................... 12 
Import 

Protocol ............................................... 61 
Install 

CPCOM ............................................... 65 
Drivers ................................................. 66 

Interpretation ........................................... 40 
History ................................................. 41 
Statements .......................................... 30 
Tab ...................................................... 13 

Lead 
Preference ........................................... 48 
Sequence ............................................ 49 

Maintaining ............................................. 45 
Manually print ......................................... 43 
Markers ................................................... 10 

Change ................................................ 33 
Display ................................................ 32 

Measure blood pressure ......................... 20 
Measurements ........................................ 32 
Monitor .............................................. 10, 19 

Tab ...................................................... 52 
Muscle noise 

Filter .................................................... 23 
Muscle noise filter ................................... 12 
New exercise ECG 

Create ................................................. 14 
New protocol 

Create ................................................. 61 
New stage 

Create ................................................. 62 
pacemaker signal indicators ....... 12, 25, 49 
PCI CPCOM card ................................... 68 
PCMCIA CPCOM ................................... 69 
Phases ................................................ 9, 58 
Precordial electrodes 

Connect ............................................... 15 
Print .................................................. 26, 43 

Automatically ....................................... 58 
Button .................................................. 11 
Formats ............................................... 44 
Protocol ......................................... 16, 59 
Selection ............................................. 49 
Tab ...................................................... 51 

Protocol ......................................... 9, 16, 58 
Default ................................................. 53 

QRS .................................................. 31, 33 
Rate pressure product ............................ 37 
Real-time monitor .................10, 14, 19, 23 
Record 

Exercise ECG ...................................... 13 
Recorder 

Connection ......................................... 54 
Maintaining ......................................... 45 
Options ............................................... 54 
Tab ..................................................... 54 

Recover 
Test after crash .................................. 63 

Recovery ................................................ 58 
Phase ........................................... 50, 62 

Reference complex ................................ 10 
Set ...................................................... 32 

Reference Point ..................................... 32 
ST ....................................................... 48 

Replace battery ...................................... 45 
RPP .......................See Rate Pressure Product 
RS232 Unilink ........................................ 65 

Connect .............................................. 66 
Selections 

Define ................................................. 49 
Sensitivity ............................................... 20 
Show Pacer ............................................ 49 
Slopes .............................................. 31, 36 

Display ................................................ 37 
Speed ............................................... 20, 28 

Unit ..................................................... 48 
Speed/elevation ..................................... 53 

Adjust ................................................. 23 
ST 

Calculation .......................................... 48 
Copy measurements .......................... 38 
Elevation or depression ...................... 13 
Maximum level ................................... 35 
Options ............................................... 48 
Point ................................................... 13 
Reference Point.................................. 36 
Slopes ................................................ 37 
Tab ..................................................... 13 
Table ...................................... 31, 37, 49 
Trend .................................................. 36 
Value .................................................. 31 

ST/HR view ............................................ 39 
ST/slope tab ........................................... 13 
Stages .......................................... 9, 58, 59 

Create new ......................................... 62 
Delete ................................................. 62 
Edit ..................................................... 62 

Start button ............................................ 19 
Stop test button ...................................... 19 
Summary 

Customize report ................................ 55 
Tab ..................................................... 55 
Tab ..................................................... 56 
View .................................................... 30 

Target heart rate ........................ 16, 26, 27 
Treadmill 

Adjust speed/elevation ....................... 23 
Protocol .............................................. 59 

Trends .................................................... 13 



 
CardioPerfect Workstation 

Exercise ECG Module - User Manual 
 

DIR 80012335 Ver. E  83 / 83 

Tab ...................................................... 12 
View .................................................... 36 

Unilink ..................................................... 65 
USB ............................................ 14, 65, 66 
View 

Exercise ECG ...................................... 28 
Interpretation history ........................... 41 

Viewing tab ............................................ 49 
Workload ................................................ 12 

Change ............................................... 24 
Default protocol .................................. 53 
Graph ................................................. 36 
View changes ..................................... 34 

Zoom ...................................................... 28 
 


	1.  Getting started
	1.1  The Welch Allyn CardioPerfect Exercise ECG window
	1.2  Structure of an exercise ECG

	2.  Recording an exercise ECG
	2.1  The Real-time monitor
	2.2  Record an exercise ECG
	2.2.1. Place electrodes on the patient
	2.2.2. Select or create a new patient
	2.2.3. Create a new exercise ECG
	2.2.4.  Add Physicians to the test

	2.3  Real-time monitor
	2.3.1. Select how you want to view leads
	2.3.2. Measure blood pressure
	2.3.3. Capture an event
	2.3.4. Patient Perception Parameters
	2.3.5. Duke Treadmill Score
	2.3.6. Add a comment
	2.3.7. Apply filters
	2.3.8. Manual load change
	2.3.9. Pacemaker pulse detection
	2.3.10. Signal quality indication
	2.3.11. Printing during recording
	2.3.12. Target heart rate
	2.3.13. Target Workload


	3.  Viewing an exercise ECG
	3.1  About viewing exercise ECGs
	3.2  View an exercise ECG
	3.2.1. Zoom in and out on an exercise ECG
	3.2.2. Set chart speed and sensitivity
	3.2.3. Navigate through recording time
	3.2.4. Copy into other applications:
	3.2.5. Post-test editing of tests

	3.3  Work with the Summary view
	3.4  Work with the Averages view
	3.4.1. Averages view
	3.4.2. Display markers
	3.4.3. Make measurements
	3.4.4. Set reference complex
	3.4.5. Compare averages with full disclosure data
	3.4.6. Change QRS onset and QRS end markers

	3.5  Work with the Full disclosure view
	3.5.1. Full disclosure view
	3.5.2. View leads
	3.5.3. Insert events after recording
	3.5.4. Use filters

	1.1
	3.6  Work with the 2x6, 4x3, and Rhythm views
	3.6.1. Use filters

	3.7  Work with the Trends view
	3.7.1. Set a different ST reference point
	3.7.2. Display ST slopes

	3.8  Work with the ST table view
	3.8.1. Rate pressure product
	3.8.2. Copy ST measurements into other applications:

	3.9  Work with the Heart rate view
	3.9.1. Heart rate view
	3.9.2. Compare heart rate graphs

	3.10  Work with the ST/HR view
	3.10.1. ST/HR view


	4.  Interpreting an exercise ECG
	4.1  Edit, save and confirm interpretation
	4.2  View interpretation history
	4.3  Clean up full disclosure

	5.  Printing an exercise ECG
	5.1  Print an exercise ECG
	5.1.1. Print formats

	5.2  Automatically print an exercise ECG

	6.  Maintaining the recorder
	6.1  About maintaining the recorder
	6.2  Cleaning the Patient cables and PC interface cables
	6.3  Replace the battery of the recorder
	6.3.1. Welch Allyn CardioPerfect MD recorders
	6.3.2. Welch Allyn CardioPerfect Pro recorders


	7. Customizing the Exercise ECG module
	7.1  Exercise ECG settings- General tab
	7.2  Exercise ECG settings- Viewing tab
	7.2.1. Selections for viewing and printing

	7.3  Exercise ECG settings- Printing tab
	7.3.1. Set selected formats

	7.4  Exercise ECG-settings- Monitor tab
	7.5   Exercise ECG-settings -Devices tab
	7.6   Exercise ECG settings- Recorder tab
	7.7   Exercise ECG settings- Summary tab

	8.  Customize exercise protocols
	8.1  Protocols, phases and stages
	8.2  Exercise Protocols overview
	8.2.1. Ergometer protocols
	8.2.2. Treadmill protocols

	8.3  Blood pressure and Printer protocols
	8.3.1. Blood pressure of printer protocol modes

	8.4  Protocol editor window
	8.5  Working with protocols
	8.5.1. Create a new protocol
	8.5.2. Import a protocol
	8.5.3. Delete a protocol

	8.6  Working with stages
	8.6.1. Create a new stage
	8.6.2. Edit a stage
	8.6.3. Delete a stage


	9.  Troubleshooting
	9.1  Test recovery
	9.2  Troubleshooting
	9.3  Technical Support

	10.  Before installing the Exercise ECG software
	10.1  Structure

	11.  Installing the Exercise ECG Module
	11.1  Connecting the RS232 interface (Rest or Stress light versions)
	11.2  Connecting the USB Interface
	11.3  R-wave triggering Interface capabilities
	11.4  Install the PCI CPCOM card (MD recorder only)
	11.5  Install the PCMCIA CPCOM Card (MD recorder only)

	12.  Safety and precautions
	12.1  Conventions
	12.2  General Safety and Precautions tips

	13. Guidance and Manufacturer’s Declarations
	14.  Function keys
	15.  Additional information
	15.1  Duke Treadmill score
	15.2  Mets Value


